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Read Me First 
 
Welcome to Take Control of MobileMe, Second Edition, version 2.0, 
published in October 2010 by TidBITS Publishing Inc. This book 
was written by Joe Kissell and edited by Dan Frakes. 

Membership in MobileMe gives you access to a suite of online ser-
vices that both complements and integrates tightly with Mac OS X 
and iLife. Although MobileMe was designed for ease of use, it also 
has tremendous power—and a few hidden pitfalls. Learn how to 
make the most of your MobileMe membership by reading this book, 
which goes far beyond Apple’s online help to give you detailed 
instructions, tips, and strategies. 

Copyright © 2008, 2009, 2010, Joe Kissell. All rights reserved. 

If you have an ebook version of this title, please note that if you 
want to share it with a friend, we ask that you do so as you would 
a physical book: “lend” it for a quick look, but ask your friend to buy 
a new copy to read it more carefully or to keep it for reference. 
Discounted classroom and Mac user group copies are also available. 

UPDATES AND MORE 
You can access extras related to this book on the Web (use the link 
in Ebook Extras, near the end of the book; it’s available only to pur-
chasers). On the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or 
purchase any subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB 
and Mobipocket. (Learn about reading this ebook on handheld 
devices at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top 
of the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

http://www.takecontrolbooks.com/class-copies
http://www.takecontrolbooks.com/device-advice
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BASICS 
In reading this book, you may get stuck if you don’t know certain basic 
facts about MobileMe or Mac OS X, or if you don’t understand Take 
Control syntax for things like working with menus or finding items 
in the Finder.  

Please note the following: 

• Menus: To describe choosing a command from a menu, I use an 
abbreviated description. For example, my description of the menu 
command to create a new folder in the Finder would be “File > New 
Folder,” that is, “choose New Folder from the File menu.” 

• Multiple ways to perform an action: You can perform many 
actions in more than one way—for example, using a button, a menu 
command, or a keyboard shortcut. In this book, for the sake of 
brevity, I usually mention only one way to perform each action. In 
general, I describe the most obvious way—buttons are often easier 
to find than menu commands, which are in turn more obvious than 
keyboard shortcuts—but choose whichever approach suits you best. 

• Finding preference panes: I sometimes refer 
to system-wide Mac OS X preferences you may want 
to adjust. To do so, open System Preferences by clicking 
its icon in the Dock (shown beside this paragraph) or 
choosing System Preferences from the Apple () menu. Settings 
are categorized in topic-specific preference panes. You access 
a preference pane by clicking its icon. For example, to see “the 
MobileMe preference pane,” open System Preferences and click 
the MobileMe icon. 

• Path syntax: I occasionally use a path to show the location of 
a file or folder in your file system. For example, Mac OS X stores 
most utilities, such as Terminal, in the Utilities folder. The path 
to Terminal is: /Applications/Utilities/Terminal. The slash at the 
start of the path tells you to start from the root level of the disk. 
You will also encounter paths that begin with ~ (tilde), which is a 
shortcut for a user’s home directory. For example, if a person with 
the user name joe wants to install fonts that only he can access, he 
would install them in his ~/Library/Fonts folder, which is another 
way of writing /Users/joe/Library/Fonts. 
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WHAT’S NEW IN THE SECOND EDITION 
A great many changes affecting MobileMe have occurred since version 
1.2 of this book was released. The iPad appeared, as did the iPhone 4 
and iOS 4; Mac OS X 10.6 Snow Leopard was released, as was iLife ’11; 
and the MobileMe Web site got a major overhaul (especially the Mail 
and Calendar applications). The second edition of this book is an 
attempt to bring it up to date with these new developments. Although 
the book contains numerous changes, the most significant are these: 

• Added coverage of the new site layout, navigation controls, toolbars, 
and other changes in Navigate the MobileMe Web Site. 

• Updated the section A Word about Push Synchronization so that it 
remains correct for 10.5 Leopard while also more fully describing 
Snow Leopard and iOS. 

• Completely revised the discussion of Notes, which now sync via 
push across Macs and some iOS devices. 

• Thoroughly updated the Mail chapter to account for changes such 
as a new layout, styled text, server-based rules, support for multiple 
From addresses and POP accounts, and greatly revised preferences. 

• Gave the Calendar chapter a massive makeover to reflect the sweep-
ing changes to the MobileMe Calendar application. 

• Updated the iDisk chapter to keep it current with the latest user 
interface and feature changes. 

• Broke out Find My iPhone as its own chapter and expanded it 
significantly, now that Apple has added to Find My iPhone’s 
capabilities and put it in a new location on the Mobile Me site. 

• When iLife comes up, I discuss iLife ’11 and iLife ’09. (I dropped 
coverage of iLife ’08, and Apple never released an iLife ’10.) 

WHAT WAS NEW IN VERSION 1.2 
Version 1.2 added instructions for using Apple’s then-new MobileMe 
iDisk app for iPhone and iPod touch (see Connect Using an iOS 
Device) and removed one tiny leftover mention of .Mac Groups. 



8 

Introduction 
 

 
In 2000, Apple introduced iTools, a free set of Internet services 
including such useful features as an email address in the mac.com 
domain and online storage space called iDisk. Over the following 
decade, this package evolved significantly. It switched from a free 
service to a paid one; it changed its name to .Mac in 2002 and then, 
in 2008, to MobileMe; it added and removed features; and it repeat-
edly updated its look and feel. MobileMe continues to change, but 
at its core is a powerful set of features that can simplify and enhance 
your digital life. 

People frequently ask me whether I still think MobileMe is relevant—
and in particular, whether it’s still worth the money. It’s true that other 
providers offer services comparable to portions of MobileMe at no cost, 
that MobileMe has had (and continues to have) some rough spots, and 
that Apple’s service still lacks certain key capabilities that competitors 
have. For example, you can get free email, online calendars and con-
tacts, Web hosting, and cloud storage from Google. So, the thinking 
goes, why pay for what you can get for free? 

I’m not going to try to talk you into using MobileMe or talk you out 
of using other services. But I do want to make a brief case for what’s 
uniquely great about MobileMe: 

• Ease of use. MobileMe is a showcase for Apple’s legendary user 
interface finesse, and tasks that are complicated to perform in other 
services are a piece of cake in MobileMe. This is especially evident 
when setting up syncing for multiple types of data across several 
devices—particularly compared to analogous services from Google. 

• Integration. The components of MobileMe work brilliantly 
and seamlessly with each other, as well as with Mac OS X and 
iOS and their associated applications. Other services require you 
to go through several distinct setup procedures, and still don’t tie 
in as closely to, for example, iLife and iWork, as MobileMe does. 
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• Find My iOS Device. MobileMe is the only service that lets you 
locate (and optionally disable) an iPhone, iPad, or iPod touch no 
matter where in the world that device is located. 

In short, if most of the devices you use for computing, communication, 
and entertainment are made by Apple, MobileMe has a lot to offer. 

The goal of this book is to help you get the most out of MobileMe. 
I want to be clear, however, that this book is not a troubleshooting 
guide. Although I’ve included a few tips that address common com-
plaints, I can’t offer help for problems that involve errors or outages 
on Apple’s end, network issues between your computer and Apple, 
or other random problems. If something isn’t working the way this 
book describes, the most likely reason is that Apple’s servers or soft-
ware are misbehaving, or that a network issue is affecting your connec-
tion to those servers. I can commiserate with you, because whatever 
the problem is, I’m probably experiencing it, too, but I can’t offer any 
magic fixes for problems that only Apple can solve. 

I’ve been using MobileMe and its predecessors since day one, and 
I’ve been writing books about it since 2005—in other words, for half 
the product’s lifetime! In that time, a lot has changed, but one thing 
that’s stayed the same is the absence of a detailed instruction manual. 
Although online help is available for MobileMe, it’s not terribly tho-
rough or helpful. I’ve written this book to fill that gap—to help you take 
control of every aspect of your MobileMe membership and get as much 
value out of it as you can. As Apple continues to modify the MobileMe 
services, I plan to update this book, as well, so that you’ll always have 
the latest information. 

According to Apple, MobileMe works with Macs, Windows PCs, and 
iOS devices. In practice, though, Apple products, and especially Macs, 
are far better supported than other devices. Apple says the minimum 
system requirement for Macs is Mac OS X 10.5.8 (Leopard); for iPhone 
and iPod touch, iOS 3.1.3; and for iPad, iOS 3.2. As a result, I say noth-
ing here about older operating systems. And, although I do discuss 
Windows and, to some extent, iOS devices, most of the book, like 
MobileMe itself, focuses on Mac OS X. Likewise, because MobileMe 
is so tightly tied to iLife, which itself gets regular overhauls, I focus on 
iLife ’11, the latest iLife version as I write this, with notes as to where 
it differs from the previous version, iLife ’09. 
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MobileMe Quick Start 
 
You can read the entire book in order, or click a blue link below to 
immediately jump to any particular topic. If you are completely new 
to MobileMe, however, I strongly recommend reading Get to Know 
MobileMe first. 

 

Get started: 
• Learn about MobileMe features. See Get to Know MobileMe. 

• Set up your Mac, PC, or mobile device to work with MobileMe, and 
learn how to use the MobileMe Web site. Read Set Up and Explore 
MobileMe. 

• Make sure your computer(s) and mobile device(s) can share infor-
mation with MobileMe. Read Keep Your Data in Sync. 

Use the six core MobileMe applications: 
• Send and receive email with Mail. 

• Manage your address book using Contacts. 

• Keep track of your schedule and to-do items with Calendar. 

• Share photos and movies online using Gallery. 

• Store and share files on your iDisk. 

• Locate a wayward iOS device with Find My iPhone. 

Go beyond the basics: 
• Manage your MobileMe Account. 

• Use MobileMe and iLife together to create Web sites. 

• Access stuff on a faraway Mac using Back to My Mac. See Access 
Your Mac Remotely. 

• Back Up Your Files—to an iDisk or another destination.  

• Convert your MobileMe account from one type to another, if the 
need arises. See Appendix A: Account Conversion Methods. 
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Get to Know MobileMe 
 
What exactly is MobileMe? This set of Internet services has many 
facets—some of them quite obvious, and others that function 
invisibly but powerfully in the background. Before going further, 
I want to review what your MobileMe membership includes. 

WHAT IS MOBILEME? 
You can go to an Apple Store and walk out with a “MobileMe” box, 
but it won’t contain any hardware or software. The main thing in it is 
an activation code that you can use to turn on your MobileMe features; 
you can just as easily purchase your membership online and save a tree 
branch or two. Rather, MobileMe is a collection of online services—
some of which you can use on their own, and some of which add 
capabilities to your Mac, Windows PC, iPhone, iPad, or iPod touch. 

MAJOR MOBILEME FEATURES 
Although Apple is constantly tweaking the capabilities of MobileMe, 
here are the major features as of September 2010: 

• Synchronization: If you have more than one computer (or a 
computer plus an iPhone, iPad, or iPod touch), you can keep key 
information—your contacts, calendar, and more—in sync on all of 
them automatically. I cover the details in Keep Your Data in Sync. 

• MobileMe Mail: Your MobileMe membership includes one or 
more email addresses (using the format member-name@me.com 
or member-name@mac.com); you can check and send email via 
the MobileMe Web site or use a program such as Apple Mail. For 
details, see Mail. You can also use your MobileMe address for 
instant messaging with iChat or AOL Instant Messenger (AIM). 

• Contacts: Sync the address book from your Mac or PC with other 
computers, your iPhone, iPad, or iPod touch, and the MobileMe 
Web site. To learn more, see Contacts. 
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• Calendar: Synchronize calendar events between devices and with 
the MobileMe Web site. You can also view and edit your calendars 
as easily on the Web as you can on your computer or mobile device. 
See Calendar. 

• Gallery: Share photos and movies on the Web with MobileMe 
Gallery, a slick media-viewing interface. You can grant access to 
friends and family members so they can upload their own media to 
your gallery, and you can view these galleries using an iPhone, iPad, 
iPod touch, or Apple TV. Read Gallery. 

• iDisk: With this online storage space, you can access selected files 
from nearly any computer with an Internet connection (and even 
from an iPhone, iPad, or iPod touch). You can also publish Web 
sites and share files with other people. See iDisk. 

• Find My iPhone: If you’re separated from your iPhone, iPad, or 
iPod touch, you can use MobileMe to locate it almost anywhere in 
the world—and remotely erase its data if you can’t retrieve the 
phone. See Find My iPhone. 

• iLife integration: MobileMe and iLife have always had a friendly 
relationship, and iLife ’11 provides especially rich integration with 
you MobileMe account. Read MobileMe and iLife. 

• Back to My Mac: If your Macs are in different locations, you can 
now access files on and share the screen of a remote Mac with a few 
clicks. See Access Your Mac Remotely. 

• Backup: MobileMe members can download a backup application 
called Backup—though it’s generally not the best tool for the job. 
Consult Back Up Your Files for an explanation. 

MobileMe is not the only way to get most of these features, but the 
single, easy-to-use package makes it a great choice—especially if you 
have an iPhone, iPad, iPod touch, or more than one Mac. 

MobileMe accounts are designed to be used by a single person. With 
a Family Pack, you can get accounts for five people for less than the 
cost of two individual memberships. The catch is that only the main 
account holder gets the full amount of iDisk and email storage space; 
the other four Family Members (as Apple calls them) get somewhat 
reduced quotas—see iDisk for details. 
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Save Money on Your MobileMe Membership 
Buying a membership or renewal directly from Apple costs $99 
for individuals or $149 for a five-user Family Pack. But I’ve seen 
prices well under $80 and $110, respectively, at other sites. (Yes, 
you can use a retail box to renew an existing membership.) Some 
good places to check for discounted MobileMe retail boxes are: 

• Amazon.com: http://www.amazon.com/ 

• dealmac: http://www.dealmac.com/ 

• Buy.com: http://www.buy.com/ 

http://www.amazon.com/gp/redirect.html?ie=UTF8&location=http%3A%2F%2Fwww.amazon.com%2F&tag=altconcepts-20&linkCode=ur2
http://www.dealmac.com/
http://www.buy.com/
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Set Up and Explore 
MobileMe 
 
Before you can do useful things with MobileMe, you must set up 
your Mac, PC, and mobile device(s) properly. In this chapter, I 
describe setup procedures for Mac OS X, Windows, and iOS devices, 
and walk you through using the MobileMe Web site. 

This chapter assumes you’ve already activated your membership 
with Apple; if you haven’t, go to http://www.me.com/activate, enter 
your activation key, and follow the onscreen instructions. 

SET UP MOBILEME ON A MAC 
If you’re using Mac OS X, only one small item requires your initial 
attention. (I discuss other settings later.) Follow these steps: 

1. Be sure that you’re running the latest version of Mac OS X. If you’re 
using Snow Leopard, you must have version 10.6.3 or higher 
installed; if you’re using Leopard, you need version 10.5.8. In either 
case, if your system software is an earlier version, choose Apple 
() > Software Update and follow the prompts to install the latest 
version. 

2. Open MobileMe System Preferences. 

3. If the window looks like Figure 1 (with fields provided for Member 
Name and Password), fill in these fields and click Sign In. 

http://www.me.com/activate


15 

 
Figure 1: Enter your member name and password in the MobileMe 
pane (if you haven’t already done so). 

After you sign in, the MobileMe pane displays more information about 
your account, as well as additional views—Account, Sync, iDisk, and 
Back to My Mac (Figure 2). 

 
Figure 2: After you sign in, the pane has more options. 

Your Mac is now configured to use MobileMe, and your iDisk should 
appear in the sidebar of Finder windows.  
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Member Name Longevity 
Once you choose a MobileMe member name—even for a trial 
account—that name is yours (more or less) forever. Even if you let 
your subscription lapse, no one else can claim that member name. 
You can reactivate your account later, keeping the same member 
name, although any data stored on Apple’s servers, such as email 
and contacts, will likely be gone—that data is deleted 15 days 
after your membership expires. 

On the other hand, if you set up an email alias (see Addresses 
Preferences) and later delete it, not even you can use that name 
in the future—it’s permanently removed from the pool of available 
MobileMe member names. 

If you have an older membername@mac.com address, you 
can continue to use it for iChat, even after your subscription 
has expired, though not for encrypted iChat. However, 
membername@me.com addresses can’t be used for iChat at all 
once your account expires. 

SET UP MOBILEME UNDER WINDOWS 
You can access your MobileMe account and Web applications at 
http://www.me.com/ from a Windows Web browser without any 
preliminary setup. However, to synchronize your contacts, calendars, 
and bookmarks, you must use the MobileMe control panel, which is 
(rather unintuitively) installed with iTunes 9.2 or higher. 

You can download iTunes from http://www.apple.com/itunes/ 
download/. After installing it, skip ahead to Keep Your Data in Sync 
for instructions on setting up syncing. 

http://www.me.com/
http://www.apple.com/itunes/download/
http://www.apple.com/itunes/download/


17 

MobileMe Limitations under Windows 
These days, MobileMe has much better support for Windows than 
it once did. Even so, some limitations remain: 

• Because Apple has not released a Windows version of iLife, 
Windows users can’t take advantage of MobileMe’s integration 
with iWeb, iPhoto, iMovie, and GarageBand. 

• Windows doesn’t include a calendar application that integrates 
with MobileMe, so only those Windows users running Outlook 
2007 or 2010 can sync calendar events. 

• Access to your iDisk is more cumbersome than on a Mac, and 
local iDisk syncing is not an option. 

• Some kinds of data (including Dashboard widgets, Dock items, 
keychains, and preferences) can sync only between Macs. 

• There’s no equivalent to Back to My Mac for Windows. 

• Apple’s Backup application isn’t available for Windows—but 
that’s a small loss, as I don’t even recommend it on a Mac. 

• Accessing the MobileMe Web site in Windows requires Safari 4 
or later (free from http://www.apple.com/safari/), Firefox 
version 3.6 or later (free from http://www.getfirefox.com/), 
or Internet Explorer 8 or later (http://www.microsoft.com/ 
windows/internet-explorer/). Internet Explorer version 7 is only 
partially supported, and it is slow; older versions of Internet 
Explorer don’t work at all. 

SET UP MOBILEME ON AN iOS DEVICE 
If you have an iPhone, iPad, or iPod touch, you should also configure 
it to access your MobileMe account. Apple provides nicely detailed 
instructions on their Web site for doing this, and rather than repeat 
them here, I’d like to direct you to the following Web page, where you 
can read all about it yourself: http://www.apple.com/mobileme/ 
setup/iphone_ipod.html. 

The short version of the instructions is: install the latest version of 
iTunes for Mac OS X or Windows; enter your MobileMe account data 
on your portable device; and make sure both push synchronization and 
Find My iPhone are enabled. 

http://www.apple.com/safari/
http://www.getfirefox.com/
http://www.microsoft.com/windows/internet-explorer/
http://www.microsoft.com/windows/internet-explorer/
http://www.apple.com/mobileme/setup/iphone_ipod.html
http://www.apple.com/mobileme/setup/iphone_ipod.html
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NAVIGATE THE MOBILEME WEB SITE 
You’ll probably visit the MobileMe Web site at http://www.me.com/ 
frequently. Because the site has a rather sparse layout, I’d like to give 
you the nickel tour to help you get your bearings. 

Browser reminder: If you’re running Windows, keep in mind that 
although you can sign in to MobileMe with Internet Explorer 7, parts 
of the site won’t work. Use Safari, Firefox, or Internet Explorer 8 or 
later for best results. 

Sign In 
To sign in to the MobileMe site: 

1. Go to http://www.me.com (Figure 3). 

 
Figure 3: The MobileMe sign-in page as it appears in Safari. 

2. Enter your member name and password. 

Name game: Your member name is the part of your MobileMe 
email address before the @ sign. You can also enter your full 
address (membername@me.com or membername@mac.com) to sign 
in. (I say more about the me.com-versus-mac.com distinction later, 
in the sidebar Me.com vs. Mac.com Addresses.) 

http://www.me.com/
http://www.me.com/
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3. Optionally, check Keep Me Signed In for Two Weeks if you’re using 
your own computer and feel comfortable that no one else will try to 
access your account with it. 

4. If you want to go directly to a particular MobileMe application 
(Mail, Contacts, Calendar, Gallery, iDisk, or Find My iPhone), click 
the application name. 

Applying a new term: Apple now calls the various modules on 
the MobileMe Web site “applications,” so I use that term here too. 
Just keep in mind they’re Web applications, as opposed to conven-
tional stand-alone applications. 

5. Click Sign In. 

Sign of the times: Everything you do on the MobileMe Web site 
requires you to sign in first, so from here on, I’ll merely mention 
that you must be signed in, and not walk you through the steps to 
get there. 

After you sign in, MobileMe takes you to the application you selected 
on the sign-in page; if you didn’t select one, MobileMe displays 
whichever application you last used (or, if this is your first visit, Mail). 
Keep reading to learn how to navigate to other parts of the site. 

The Toolbar 
After you’ve signed in, a dark blue toolbar appears at the top of every 
page of the MobileMe Web site. The toolbar controls are divided into 
three main groups—navigation, application-specific controls, and site-
wide controls. 

Navigation Controls 
Previously, the left side of the toolbar displayed buttons for each of the 
MobileMe applications, so you simply clicked a button to switch to that 
application. As part of a mid-2010 redesign, however, Apple replaced 
this set of buttons with just one, showing the MobileMe cloud icon . 
Click this button to display a pop-up application switcher (Figure 4); 
then click a button to jump to the corresponding application. 
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Figure 4: Use these buttons to move from application to application 
within the MobileMe site. 

When this application switcher first appeared, I was annoyed that 
it now took two clicks instead of just one to move from one place to 
another. However, this aggravation is offset somewhat by the fact that 
you can now select an application before signing in, by MobileMe’s 
remembering which application you used last, and by the availability of 
keyboard shortcuts. Instead of clicking the cloud button, you can press 
Shift-Esc to display the application switcher; use the arrow keys to 
move left or right; and then press Return to switch to an application. 

Application-Specific Controls 
The center of the toolbar contains a group of icons; this area changes 
depending on which application you’re currently using. For example, 
the icons for the Mail application (Figure 5) include controls for 
deleting, archiving, moving, replying to, forwarding, and composing 
email messages. (The Mail and Contacts applications also have Search 
fields to the left of this set of controls; I discuss those later.)  

 
Figure 5: The center group of icons on the toolbar changes as you 
switch applications (the Mail icons are shown here). 

In every application except Find My iPhone, the Actions  pop-up 
menu also appears near the right side of the toolbar. If you’re trying 
to figure out how to perform some action and you don’t see any other 
controls that seem to apply, the Actions menu likely contains what 
you’re looking for—it’s a sort of catchall menu for commands that 
aren’t used quite frequently enough to merit their own icons. 

For example, the Actions menu usually contains a Preferences com-
mand to let you configure settings for the current application; in the 
Mail application it also includes commands such as Mark as Unread 



21 

and Empty Trash. I cover the Actions menu in more detail in the 
discussions of individual MobileMe applications. 

Account Menu 
On the far right side of the toolbar is a pop-up menu showing your 
name; I call this the Account menu, which contains the following: 

• Account: Choose Account to manage storage settings, change your 
password, and do other tasks relating to your account as a whole. 

• Help: Choose Help to go to the MobileMe Help page (which 
provides instructions on using most of the site’s features). 

• Sign Out: To end your session, choose Sign Out. If you’re using 
your own computer, and no one else uses it, you needn’t ever sign 
out. But on a public or shared computer, you should sign out to 
ensure that no one else can access your private data. 

The Sidebar 
At the left of each application on the MobileMe site is a region called 
the sidebar that lets you navigate to different subsections, or panes, 
within a given application. For example, in the Mail application, the 
sidebar lists your mailboxes and folders; in the Contacts application, it 
lists Address Book groups; and in the Calendar application, it lists your 
calendars. In any case, the sidebar, like the middle group of controls on 
the toolbar, is always specific to the application you’re currently using. 

In most MobileMe applications, you’ll see one or more additional 
controls at the bottom of the sidebar—these usually affect items in the 
sidebar. The iDisk sidebar, for example, contains an Actions  pop-
up menu with contents distinct from those in the Actions pop-up menu 
on the toolbar , so there are two locations to look for commands. 

Need More Help? 
If you run into questions I don’t address here, keep in mind these 
other ways you can get help: 

• Use the Help menu in Mac OS X. 

• Go to the MobileMe Support page on Apple’s Web site at 
http://www.apple.com/support/mobileme/. 

• Use the MobileMe discussion forum Apple provides at 
http://discussions.apple.com/category.jspa?categoryID=116. 

http://www.apple.com/support/mobileme/
http://discussions.apple.com/category.jspa?categoryID=116
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Keep Your Data in Sync 
 
MobileMe can synchronize several kinds of information, in several 
different ways. For example, it can sync contacts, calendars, and 
Web bookmarks between computers (Mac or PC), the MobileMe 
Web site, and one or more iOS devices. Other kinds of data (such 
as Dashboard widgets and keychains) can be synced only between 
Macs. And the files on your iDisk can be synchronized only between 
a Mac and the MobileMe servers (read more about this in iDisk).  

In this chapter I cover the main ways of syncing data (including 
the sometimes-confusing notion of “push” synchronization) and 
discuss some of the issues you may encounter.  

UNDERSTAND SYNCING OPTIONS 
Apart from files on your iDisk, the kinds of data you can sync using 
MobileMe fall into three categories: those that can sync across all your 
devices (Calendars, Contacts, and Bookmarks, which I discuss in a 
moment), those that can sync only between Macs (Mac-Only Data 
Types, shortly ahead), and those that can sync across Macs and iOS 
devices (but not Windows computers)—a category currently occupied 
only by notes (see Notes). 

But before I get into the specific kinds of data you can synchronize and 
how to set that up, I want to make sure you understand a key concept 
that applies to some kinds of MobileMe data: push. 

A Word about Push Synchronization 
Let’s say you have an iPhone. One day you sign in to the MobileMe 
Web site from a computer and change a contact’s phone number. 
The question is, what has to happen for your phone to be updated? 

Well, there are three possibilities: 

• Your iPhone could check in with the server every so often (say, 
every hour, or when you manually tap a button) to see if there 
are any changes, and when it finds new data, it can download it. 



23 

• You could sync the information from the MobileMe server with your 
Mac or PC, and then plug in your iPhone and update its information 
over USB. 

• The MobileMe server could immediately send the information 
to your iPhone over the cellular network or Wi-Fi. 

That last option is what’s known as push synchronization—the server 
pushes the information to your device, rather than the device having to 
“pull” it or wait for a sync to happen (manually or on a fixed schedule). 
Push is wonderfully useful in that changes happen almost instantly, 
so your devices are more likely to be up to date at any given time, and, 
thus, synchronization conflicts are less likely. (Push doesn’t work, of 
course, if your device is without any sort of network access.) 

With MobileMe, changes made to any data on the server are delivered 
to your other devices (including iOS devices, Macs, and PCs) as soon 
as they occur—usually within a matter of seconds—assuming all are 
set up to receive push updates. Likewise, changes you make to certain 
kinds of data—such as calendars, contacts, and bookmarks—on your 
Mac or iOS device are sent immediately to the MobileMe servers 
(as long as you have an active Internet connection), as are changes 
to calendar and contact data made on a PC running Microsoft Outlook. 
So to that extent, MobileMe does offer push syncing. 

However, push isn’t available for all data types or on all platforms. 
If you update a Mac OS X preference file that syncs via MobileMe, 
for example, your Mac does not send that data immediately to the 
MobileMe servers—it may take as long as four hours for the informa-
tion to be uploaded automatically. (Apple spells out how often each 
kind of data syncs, for each operating system and in each direction, 
at http://support.apple.com/kb/TS1155.) You can, however, manually 
force an immediate sync at any time. 

Email is a special case. Because MobileMe Mail uses IMAP (unless 
you specifically set up your email client to use POP), synchronization 
is effectively a non-issue; the server always maintains the master copy 
of each message, and each device that connects to your account syncs 
with the server. However, your MobileMe account also offers optional 
push email delivery for iOS devices—although not for Apple Mail in 
Mac OS X or other email clients. 

http://support.apple.com/kb/TS1155
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If you have an iOS device, also be aware of the following:  

• Push is disabled by default; you have to turn it on (see Set Up 
Syncing on an iOS Device). If push is off, your device can fetch 
data over the air at regular intervals (or manually) instead. 

• You can choose not to enable over-the-air syncing at all and sync 
your iPhone, iPad, or iPod touch only when you plug it into your 
computer. 

Calendars, Contacts, and Bookmarks 
I mentioned push at the outset because, as it turns out, the first 
three kinds of data are the ones for which push is an option (though 
not a requirement) on every platform and in both directions—up to 
the cloud and down from the cloud: 

• Calendars: Calendar data from iCal (Mac OS X) or Outlook 
(Windows) syncs with MobileMe Calendar on the Web, with other 
Macs or PCs you own, and with the Calendar app on an iOS device. 

• Contacts: Contact data from Address Book (Mac OS X or 
Windows) or Outlook (Windows) syncs with MobileMe Contacts 
on the Web, with other Macs or PCs you own, and with the Contacts 
app on an iOS device. 

A restricted outlook: If you have an iOS device and a Windows 
PC running Outlook, you can sync your Outlook calendars and 
contacts using MobileMe—unless (as is likely) Outlook is syncing 
with an Exchange server. In that case, your iOS device must access 
the calendars and contacts directly from the Exchange server, 
rather than through MobileMe. See http://support.apple.com/ 
kb/HT2483 for details. 

• Bookmarks: Bookmarks from Safari (Mac OS X or Windows) or 
Internet Explorer 7 or later (Windows) sync with other Macs or PCs, 
and with Safari on an iPhone or an iPod touch. Unfortunately, sync-
ing Firefox bookmarks isn’t supported on either platform. 

I want to make clear that Apple assumes you’ll be syncing calendar, 
contact, and bookmark data only with other devices you own (or of 
which you are the primary user). MobileMe is not designed to syn-
chronize information between users. One exception is calendar data: 

http://support.apple.com/kb/HT2483
http://support.apple.com/kb/HT2483


25 

MobileMe recently made it possible to share calendars between users 
in truly useful ways; see Calendar. However, if your calendar-syncing 
needs go beyond what MobileMe offers, I suggest using BusySync 
(http://www.busymac.com/; $25 per computer, Mac OS X only). 

To learn how to set up syncing, skip ahead to Set Up Syncing on a Mac 
or PC or Set Up Syncing on an iOS Device; or keep reading to learn 
about data that MobileMe can sync only between Macs. 

Tethered vs. Over-the-Air Syncing 
By default, your iOS device syncs all its data over USB, using 
iTunes as a conduit. One advantage of tethered syncing is that 
you can synchronize any iCal calendar—your own or remote ones 
to which you’ve subscribed. (With over-the-air syncing, only local 
and MobileMe calendars are synchronized.) 

If you turn on over-the-air (MobileMe) syncing as described in Set 
Up Syncing on an iOS Device, iTunes no longer mediates the 
syncing of calendars, contacts, and bookmarks—they happen only 
wirelessly. Push is available only with over-the-air syncing, though 
you can opt for fetch or manual syncing over the air. 
 

Mac-Only Data Types 
If you have more than one Mac, you can use MobileMe to synchronize 
several other kinds of data: 

• Dashboard widget settings: MobileMe syncs the settings for 
your widgets—not the widgets themselves. So if you have any third-
party widgets, you must separately download and install them on 
each Mac. Once you’ve done that, their settings will synchronize. 

• Dock item settings: As with Dashboard widgets, MobileMe 
allows you to sync Dock settings, but not the files or folders referred 
to by icons in your Dock. Syncing Dock settings never results in 
nonfunctional icons—ones pointing to nonexistent files—appearing 
in your Dock, nor does it actually copy files between your Macs. 

• Keychains: Mac OS X stores user names, passwords, and other 
sensitive data in files called keychains. Every user has at least one 
keychain, but you may have several. By enabling the Keychains 
option, you can sync your keychains between Macs. 

http://www.busymac.com/
http://www.busymac.com/
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• Mail settings: MobileMe can sync account settings (user name, 
server addresses, and so on) for all the accounts set up in Mail—
though not your email messages themselves. Separately from the 
main account settings, MobileMe can sync Mail rules, signatures, 
and smart mailboxes. 

Staying in touch: If you have an iOS device, you can also sync 
your Mail accounts with it via iTunes. However, that’s completely 
separate from MobileMe syncing. 

• Preferences: With this checked, MobileMe syncs some of the 
preference files from ~/Library/Preferences. Apple omits system-
level preferences (stored in /Library/Preferences) and several other 
kinds of data. (Read Apple’s description of what does and doesn’t 
sync at http://support.apple.com/kb/HT2085.) 

• Other data types: Some third-party applications, such as Yojimbo 
and Transmit, may add checkboxes to the list, as well. 

 

Notes 
Notes can contain the same kinds of data as email messages—plain or 
styled text and graphics—but are typically used to store brief remind-
ers, comments, lists, and other random snippets of information you 
want to keep track of. 

Mail in Mac OS X lets you keep notes in your Inbox or a special Notes 
mailbox. You can choose, within Mail, whether to store these locally 
(“On My Mac”) or in the Notes mailbox of a server-based (IMAP, 
MobileMe, or Exchange) account. To do this, choose Mail > 
Preferences, click Composing, and make your choice from the Create 
Notes and To Dos In pop-up menu. 

Meanwhile, on iOS devices, there’s a separate app, called Notes, that 
holds your notes and can sync with the notes stored on your Mac or 
on a mail server. However, note syncing for iOS devices involves some 
qualifications: 

• Under iOS 3.x, notes can sync with Mail in Mac OS X only via 
iTunes over a USB connection. 

• If your device uses iOS 4.1 or later, notes can sync wirelessly. 
However, this capability isn’t available on the iPhone 3G or on 

http://support.apple.com/kb/HT2085
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the second-generation iPod touch; those devices must sync their 
notes over USB. (iOS 4.0 didn’t have this limitation, but because 
of the other significant improvements in iOS 4.1 and later, I can’t 
recommend sticking with iOS 4.0.x.) 

• Even when wireless syncing is supported, it can be used only with 
IMAP and MobileMe accounts, not with Exchange accounts. 

Closed Windows: Unfortunately, MobileMe offers no way to sync 
notes on a Mac or an iOS device with Windows. 

If your Mac OS X Mail preferences are set to store your notes on an 
IMAP or MobileMe server, you need do nothing further on your Mac 
to set up syncing. If, however, you chose On My Mac as the location 
to store your notes, then in order to sync those notes using MobileMe, 
you must turn on syncing for notes as described just ahead. (And, to 
learn about setting up notes syncing on an iOS device, skip ahead to 
Set Up Syncing on an iOS Device.) 

Tip: Mail’s handling of notes and to-do items is odd and confusing. 
To learn more, read Take Control of Apple Mail in Snow Leopard or 
an article that I wrote for Macworld, “Master Mail’s Reminders,” at 
http://www.macworld.com/article/134122/. 

SET UP SYNCING ON A MAC OR PC 
To set up synchronization, follow these steps: 

1. Start by turning on syncing: 

• On a Mac, go to the MobileMe pane of System Preferences, click 
Sync, and then check Synchronize with MobileMe. 

• On a PC, open the MobileMe control panel, click Sync, and then 
check Sync with MobileMe. 

2. Choose an update frequency from the pop-up menu: 

• Automatically: This option means that push synchronization 
is used when possible; when it’s not possible, data is synced at  

http://www.takecontrolbooks.com/snow-leopard-apple-mail?pt=INTERNAL
http://www.macworld.com/article/134122/
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reasonably frequent regular intervals (see complete details at 
http://support.apple.com/kb/TS1155). Apple recommends this 
setting, and so do I. 

• Manually: With this setting, you must initiate every sync 
manually—by clicking the Sync Now button on this pane, or by 
using a shortcut (see Use a Sync Shortcut, ahead). 

• Every Hour, Every Day, Every Week: Synchronization 
occurs automatically at these fixed intervals, as long as your 
computer is connected to the Internet. 

3. Check the checkbox for each type of data you want to sync. (In most 
cases, you’ll probably want to select them all.)  

In Windows, use the pop-up menus to choose the applications you 
want to sync your contacts, calendars, and bookmarks with. (Note 
that if you don’t have Outlook installed, the Calendars checkbox will 
be disabled.) 

That’s it—your computer will now synchronize the designated data 
with MobileMe at the frequency you set. (If you chose Manually, click 
Sync Now to perform your first sync.) 

The first time you sync, an alert appears, similar to the one shown in 
Figure 6. The default choice, Merge All Data, is almost certainly what 
you want, so leave that selected and click Sync. 

 
Figure 6: The first time you synchronize a computer with MobileMe, 
you must choose how to merge your data. 

 

http://support.apple.com/kb/TS1155
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Use a Sync Shortcut 
In Mac OS X, you can display a MobileMe Sync  menu in your 
menu bar that provides a shortcut for performing an immediate 
sync or opening the MobileMe preference pane. In Windows, you 
can get a System Tray  icon that serves the same purpose: 

• Mac OS X: In the Sync view of the MobileMe System 
Preferences pane, check the Show Status in Menu Bar box. 

• Windows: In the MobileMe control panel, check Show in 
System Tray. 

 

Adjust the Data Change Alert 
As a safeguard against accidentally changing more data than you 
meant to, MobileMe sync includes a Data Change Alert, a window that 
pops up whenever the amount of information to be changed on your 
computer is greater than a percentage you specify (5% by default). 
That way, if you see, for example, that MobileMe sync is about to over-
write 50% of your contacts, but you recall changing only a few, you can 
stop the process before any damage occurs. 

The Data Change Alert looks something like Figure 7. It lists what 
type of data has changed beyond the amount you specified, and how 
many records of the type shown that will be added, deleted, or 
modified if you permit the sync to complete. 

 
Figure 7: This alert appears when a type of data has changed to a 
greater extent than the threshold you specified. 
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When you see this alert, click Show Details to see exactly what has 
changed, Cancel to cancel the sync, or Sync Data Type to permit the 
changes (for this data type only). If more than one type of data exceeds 
your threshold, you’ll see more than once instance of this dialog. 

To configure the Data Change Alert, follow these steps: 

1. Open the Sync preferences: 

• On a Mac, open the MobileMe pane of System Preferences. Click 
Sync; then click Advanced.  

• On a PC, open the MobileMe control panel and go to the Sync 
tab. 

2. Enable the Data Change Alert, by checking the appropriate box: 

• On a Mac: Show Alert When ___ of the Data on This Computer 
Will Be Changed 

• On a PC: Warn When ___ of This Computer’s Data Will Change 

3. If you have enabled the alert, choose a threshold from the pop-up 
menu. Your choices are: 

• Any: An alert will appear if even a single record will change. 

• More than 5%, More than 25%, More than 50%: If the 
number of records that will change exceeds this percentage of 
the total records for a given data type, an alert will appear. 

4. Finish making your changes: 

• On a Mac, click Done and then close System Preferences. 

• On a PC, click OK and close the MobileMe control panel. 

Your new settings will be used the next time you sync. 

SET UP SYNCING ON AN iOS DEVICE 
The procedure for setting up an iOS device to sync with MobileMe 
is easy but not obvious. Even if you’ve configured your mobile device 
with your MobileMe credentials, you may have to go through some 
extra steps to turn on over-the-air syncing. 
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Apple provides complete instructions for both Mac OS X and Windows 
(see http://www.apple.com/mobileme/setup/), but let me summarize 
here what you have to do: 

1. Install the latest version of iTunes (http://www.apple.com/itunes). 
On a Mac, also make sure you have the latest version of Mac OS X—
choose Apple () > Software Update. 

2. Connect your iOS device, open iTunes, and select your mobile 
device in the sidebar. 

3. On the Info pane, check all the boxes for the kinds of data you want 
to sync, click Apply, and click Sync. 

4. If you haven’t already done so, set up MobileMe syncing as 
described in Set Up Syncing on a Mac or PC and perform a sync. 

5. On your mobile device, go to Settings > Mail, Contacts, Calendars. 

6. Set Fetch New Data to Push. 

7. Select your MobileMe account. (If you haven’t set it up yet, tap Add 
Account and enter your MobileMe member name and password; 
then tap Save.) 

8. For every type of data (Mail, Contacts, Calendars, Bookmarks, and 
Notes) that you want to sync over the air, set the switch to On. 

Note: Although you can set up more than one MobileMe account 
on an iOS device, syncing of Contacts, Calendars, and Bookmarks 
can be enabled for only one of those accounts. 

9. Tap Sync. 

From now on, your iPhone or iPod touch syncs the selected data over 
the air, rather than via iTunes. 

http://www.apple.com/mobileme/setup/
http://www.apple.com/itunes
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RESOLVE SYNCHRONIZATION CONFLICTS 
If you change a piece of information in two different places between 
syncs, and the information is not exactly the same in both places, 
MobileMe won’t know which version is correct the next time that data 
syncs. (This sort of confusion is much less likely to occur with push 
synchronization than with scheduled or manual syncs, but it may still 
happen, for example, if one of the devices is unable to connect to the 
Internet when you change a piece of data.) When such a conflict 
occurs, a Conflict Resolver alert appears (Figure 8). 

 
Figure 8: Click Review Now or Review Later to resolve a conflict. 

You can resolve the conflict immediately (by clicking Review Now) or 
leave the data just as it is in both places (by clicking Review Later). 

If you click Review Now, the dialog expands to show you the details of 
the conflict(s), as in Figure 9. 
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Figure 9: Choose which version of the conflicting data to use. 

Select the version of the information you want to keep. If there are 
multiple conflicts and you’re sure that you’ll want to use the version 
of the information found on the same source—either an application 
on your computer or on the MobileMe Web site—for all the conflicts, 
check the Resolve All Similar Conflicts Using Data-Source checkbox. 
Click Continue; repeat, if necessary, for additional conflicts. 

After you’ve addressed the last conflict, another dialog appears with 
the title Save Conflict Choices. In this dialog, click Sync Now to re-
synchronize your computer with MobileMe using the new information 
you’ve just provided, Sync Later to update the data during your next 
sync, or Cancel to throw out the changes and leave the information as 
it was, in both places, before the sync. 
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RESET SYNC DATA 
Suppose you discover one day that a great deal of your synchronized 
information has changed in one of its locations—and you didn’t want 
it to. For example, perhaps you unwittingly deleted 100 important con-
tacts from your Address Book, or you experienced a computer problem 
that led to corruption in your data. Your easiest option is simply to 
start over and replace all the data in one location with all the data in 
the other location. This is called resetting your sync data. 

Pushed to the brink: Just as sync conflicts are less likely to occur 
with push synchronization than with other forms of syncing, the need 
to reset sync data is likewise lower—which is a good thing, because by 
the time you get around to resetting the data, it most likely will have 
propagated to all your devices anyway, so that it’s the same every-
where already.  
In such cases, restoring data from a backup is your only option. 
(This is one argument in favor of enabling a Data Change Alert on 
your computer[s], as described a few pages earlier—you’ll have a 
chance to approve any large changes to your synced data before the 
sync occurs.) 

When you reset your sync data, you pick a location (either your com-
puter or MobileMe) to serve as the master. The next time you sync, all 
the synchronized data from the other location is deleted and then over-
written with the data from the chosen source location. Because this 
is such a drastic measure, you shouldn’t undertake it lightly (and you 
should always back up your data first—in both locations—just in case). 

Warning! Did I mention that resetting your sync data deletes all the 
synchronized data from the other location? I believe I did, but it never 
hurts to have another reminder. Think before you sync! 

To reset your data, follow these steps: 

1. Open MobileMe’s Advanced preferences on your computer: 

• On a Mac, go to the Sync view of MobileMe System Preferences 
and click Advanced.  
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• On a PC, open the MobileMe control panel, click the Sync tab, 
and click Advanced. 

2. Click the Reset Sync Data button. A dialog appears (Figure 10). 

3. From the Replace pop-up menu, choose which data you want to 
reset: All Sync Info, or just one type (say, Contacts). If you want 
to replace more than one type of data, but not everything, you must 
repeat this entire procedure once for each type of data. 

 
Figure 10: In this dialog, choose whether data on your Mac should 
replace the data on MobileMe (as shown here) or vice-versa. 

4. Choose which location MobileMe sync should consider as primary: 

• If you click the left arrow, you’ll see the animated arrow going 
from the MobileMe icon on the right to the computer icon on the 
left. The text reads: Replace data-type(s) on this computer with 
sync info from MobileMe. So MobileMe is the master for the next 
sync, and all the data of the selected type(s) on your computer 
will be overwritten by the data from MobileMe. 

• If you click the right arrow, you’ll see the animated arrow going 
from the computer icon on the left to the MobileMe icon on the 
right. The text reads: Replace data-type(s) on MobileMe with 
sync info from this computer. So your computer is the master 
for the next sync, and all the data of the selected type(s) on 
MobileMe will be overwritten by the data from your computer. 
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5. Stop for a moment, reread the text, and be sure you have chosen the 
right direction for resetting your sync data. 

6. Click Replace. An alert asks you if you’re sure this is what you really 
want to do, reminding you that it is not undoable. Spend a moment 
pondering the sense of security you have from the backups you per-
formed earlier. (You did back up your data, right? In both places?) 
Click OK. 

A synchronization occurs immediately. When the sync is complete, 
your data will have been replaced as you specified. 

If you are syncing multiple computers to MobileMe and you’ve just 
replaced your MobileMe sync data with the information on one of 
the Macs, the next time you synchronize one of the other computers, 
it will display an alert just like the one shown on an initial sync. 

When this alert appears, you can: 

• Choose Replace Data on This Computer to completely erase the 
data type specified on this computer and replace it with the data 
from MobileMe (which, in turn, should just recently have been 
replaced by data from your other computer). 

• Choose Merge All Data to combine the data on MobileMe with 
the data on this computer—but be aware that doing so may pollute 
the data on MobileMe with extra bits of stuff that had already been 
deleted on your other Mac. 

• Choose Replace All Data on MobileMe to reverse the change, 
replacing what’s on MobileMe with what’s on this computer. (Use 
this option with caution!) 

• Stop the sync by clicking Cancel Sync. 
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Mail 
 
Each MobileMe account includes an email address in the me.com 
domain (such as jwk@me.com), which you can use with your exist-
ing email program or with MobileMe’s Web-based interface. You 
may already have an email account from your ISP or a service such 
as Google’s Gmail, but MobileMe offers some useful features that 
make it ideal as a primary or supplemental email account. 

MOBILEME MAIL BENEFITS 
Here are a few things that make MobileMe Mail great: 

• You can check your email using the www.me.com Web site or your 
favorite email software, on nearly any platform. 

• Using the MobileMe site, you can set up autoreplies (for example, 
for “out-of-the-office” and vacation notices), forward your me.com 
email to another account, check one or more POP accounts hosted 
on other servers, configure rules that automatically sort your 
messages, and more. 

• Despite scattered reports to the contrary, Apple’s mail servers 
generally provide excellent spam and virus filtering. 

• You can add up to five aliases—extra email addresses that are auto-
matically forwarded to your main Inbox. You can also configure 
MobileMe Mail to send messages with From addresses of other 
accounts you own (see Addresses Preferences). 

MobileMe Mail has improved both its appearance and its capabilities 
significantly since the last edition of this book, and if you haven’t tried 
accessing your email on the Web recently, you may be in for some 
pleasant surprises. 

One subtle but significant change is that MobileMe Mail—and the rest 
of the MobileMe Web site, for that matter—now uses SSL to encrypt 
communication with your computer. (Previously, Mail used an un-
conventional method to secure data transmission, leading many users 
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to worry that their messages could be intercepted in transit while using 
the MobileMe Web site.) 

Me.com vs. Mac.com Addresses 
If you were an active .Mac member as of July 9, 2008 (meaning 
you had a working mac.com address), your mac.com address 
will continue to work, and you can also use the same member 
name with me.com. For example, my .Mac email address was 
jwk@mac.com, and I can now use both that and jwk@me.com. 
The same applies to any email aliases you'd set up previously. 
So joekissell@mac.com still works for me, and so does 
joekissell@me.com. 

However, anyone who created a new MobileMe account on or after 
July 9, 2008 can use only the me.com address. 

ACCESS MOBILEME MAIL ON THE WEB 
To access MobileMe Mail using a Web browser, sign in to the 
MobileMe Web site and go to the Mail application (Figure 11), which 
initially shows your Inbox. 

 
Figure 11: View email in the MobileMe Mail application. 
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Webmail vs. Email Clients 
The MobileMe webmail interface is slick and getting better all the 
time. Even so, desktop email programs (or “clients”) are more 
powerful and, in some respects, easier to use. Here are some 
cases where you might prefer one method over the other: 

Use the Web interface: 
• When you’re away from your own computer 

• To change email forwarding or autoreply settings 

• To add, edit, or delete email aliases 

Use an email client:  
• To search the contents of messages 

• To redirect messages, without changing the From address 

• To use rules with greater complexity than what the MobileMe 
Web site offers 

 

Mail Overview 
As I mentioned earlier, MobileMe Mail is dramatically different from 
what Apple offered when the last edition of this book was published. 
The overall user interface has changed to more closely resemble Mail 
on the iPad, with more view options and a new array of controls. In 
addition, you can now compose messages with formatting, set up rules 
to sort your messages, check multiple POP accounts, and more. The 
webmail interface is inching ever closer to offering the capabilities of 
a stand-alone desktop email client. 

Is it a mailbox or a folder? For reasons I can’t imagine, MobileMe 
Mail uses the term “mailbox” to refer only to Inbox, Drafts, Sent, 
Trash, and Junk—all of which appear at the top of the sidebar under 
the Mailboxes heading. Other mailboxes, including Archive, Notes, 
and any user-created mailboxes, are called “folders” and thus appear 
under the Folders heading. Behind the scenes, folders and mailboxes 
are exactly the same, except that in MobileMe’s way of using the 
terms, you can make changes to folders (adding, deleting, moving, 
and renaming them) but not to mailboxes. 



40 

The main MobileMe Mail display, which shows your message list 
and mailbox/folder list, is largely self-explanatory. Here’s a quick 
overview of what you can do in this view: 

• Check for new messages: MobileMe Mail does this automati-
cally when you first sign in, and periodically thereafter, but to check 
manually at any time, click the refresh  icon at the top of the side-
bar. A blue dot  appears next to unread messages. 

• View a message: Click any message in the list; its contents appear 
in the preview pane. 

• Switch views: MobileMe Mail lets you arrange the sidebar, mes-
sage list, and preview pane in any of three configurations; choose 
the one you want from the Switch View pop-up menu (which help-
fully provides illustrative icons) at the top of the message list: 

! Widescreen: Puts the sidebar on the left, the message list in the 
middle, and the preview pane on the right. 

! Compact: Hides the sidebar, showing only the message list on 
the left and the preview pane on the right 

! Classic: Shows the sidebar but places the message list above the 
preview pane, rather than to its left 

• Resize the preview pane: Drag the bar that divides the preview 
pane from the message list. 

• Resize the sidebar: Drag the right edge of the sidebar left or 
right. 

• Sort your messages: Choose a criterion—Date, From/To, 
Subject, Unread, or Flagged—from the Sort By pop-up menu at the 
top of the message list. To reverse the sort order, choose either 
Ascending or Descending from this menu.  

• Search for a message: Enter your search text in the Search field; 
Mail begins displaying matching messages as you type. By default, 
Mail searches the current mailbox or folder; to search elsewhere, 
choose a different mailbox or folder from the first pop-up menu that 
appears at the top of the message list once the search begins. To 
specify which part(s) of messages to search, choose Any Field, 
Subject, Sender, or Recipient from the second pop-up menu. 
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Note that you can search only one mailbox or folder at a time, and 
even if you choose Any Field, only the Subject, From, To, Cc, and 
(for Sent messages) Bcc fields are searched, not message bodies. 

To return to the full message list, click the X  icon on the right 
side of the Search field. 

• View messages in another mailbox or folder: Click the 
mailbox or folder in the sidebar. Or, in Compact view (in which 
the sidebar is hidden), choose a different mailbox or folder from 
the pop-up menu in the middle of the top of the message list. (This 
menu always shows your current location.) 

Read on to learn about actions you can take with individual messages 
(such as moving, deleting, and changing read/unread status). I discuss 
other options, such as managing folders and setting preferences, 
further ahead. 

Work with Incoming Messages 
When viewing a message, you can perform almost all the usual tasks 
you might expect from an email application: 

• Delete the selected message(s): Click the Delete  icon in the 
toolbar. 

• Archive the selected message(s): Click the Archive  icon; this 
moves the message(s) to the Archive folder. (Here, MobileMe Mail 
is trying to approximate Gmail’s archiving feature, but note that the 
behavior is somewhat different in that MobileMe Mail doesn’t use 
labels or have an All Mail mailbox.) 

• Move the selected message(s) to another mailbox or 
folder: Drag the message(s) to the desired location in the 
mailbox/folder list. Or, click the Move  icon and select the new 
location from the pop-up menu. 

• Reply to the selected message: Click the Reply  icon and 
choose either Reply or Reply All from the pop-up menu that 
appears—the former replies only to the sender, while the latter 
replies to the sender as well as all other recipients of the message. 

• Forward the selected message: Click the Reply  icon and 
choose Forward from the pop-up menu that appears. 



42 

• Mark the selected message(s) as Read or Unread: Choose 
Actions  > Read or Actions  > Unread, respectively. 
Alternatively, when viewing a message you can choose Read or 
Unread from the Mark As pop-up menu in the message header. 

• Mark the selected message(s) as Junk Mail or Not Junk 
Mail: Choose Actions  > Junk Mail or Actions  > Not Junk, 
respectively, to toggle Junk status. Alternatively, when viewing a 
message you can choose Junk or Not Junk from the Mark As pop-
up menu in the message header. When you mark a message as 
Junk, MobileMe Mail moves the message to the Junk Mailbox; 
when you mark a message in that mailbox as Not Junk, Mail moves 
it back to your Inbox. 

• Mark the selected message(s) as Flagged or Unflagged: 
Choose Actions  > Flagged or Actions  > Unflagged, respec-
tively, to toggle the message’s Flagged status. Alternatively, when 
viewing a message you can choose Flagged or Unflagged from the 
Mark As pop-up menu in the message header. A small flag  icon 
appears next to flagged messages in the message list. 

• Add the selected message’s sender to your MobileMe 
Address Book: Click the sender’s email address in the message 
view. In the dialog that appears, make any desired name changes 
and then click Add. 

• Show or hide extra headers: Click the triangle next to the 
sender’s name to display the full name and email address of the 
sender and each recipient, as well as the date sent and any attach-
ments. Click the triangle again to hide the extra headers. 

• Download attachments: If a message has any attachments 
(indicated by a paperclip  icon in the header), click either the 
paperclip icon or the triangle by the sender’s name to show the extra 
headers. Then click an attachment name to download it to your Web 
browser’s default download location (and, for common file types 
such as graphics, automatically open it in Preview or the appropri-
ate default application as long as Safari’s Open “Safe” Files After 
Downloading setting remains on, as it is by default). 

• Display a “printer-friendly” version of the selected 
message in a new window: Choose Actions  > Print. 
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Compose a New Message 
To compose a new message, click the Compose New  icon in the 
toolbar. A new window appears, as shown in Figure 12. Fill in (at 
least) the To, Subject, and message fields. Click the Send  icon 
to send the message. 

 
Figure 12: Use this window to compose new email messages. 

Address a Message 
You can use any of several methods to address a message: 

• Type with autocomplete: As you type in the To, Cc, or Bcc field, 
MobileMe looks for matching contacts in your MobileMe address 
book and offers a pop-up menu of possible matches. Select a contact 
from this list (with the mouse, or by pressing the arrow keys and 
then the Return key) to use it, or just keep typing. 

Note: To include more than one addressee in the To, Cc, or Bcc 
fields, separate the email addresses with commas. 

• Consult Address Book: To address this message to someone 
in your MobileMe Address Book, click in any address field and then 
click Add . This displays a special view of your Address Book in 
which each entry has To, Cc, and (optionally) Bcc checkboxes. First, 
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locate your addressee(s) in the list (use the Search Contacts field at 
the top to find contacts quickly if the list is long). Check the To, Cc, 
or Bcc box for one or more contacts, and click OK. MobileMe Mail 
returns you to your message in progress, with the selected addresses 
entered in the fields you chose. 

A-(B)Cc: Addressees in the Cc (carbon copy) field get a copy of the 
message, with their addresses visible to all recipients. Addressees in 
the Bcc (blind carbon copy) field get a copy of the message, but their 
addresses are hidden from all recipients. You can show or hide the 
Bcc field using a setting in the Composing view of MobileMe Mail’s 
preferences (see Configure MobileMe Mail Preferences, ahead). 

Use Other Composing Tools 
Other features you may use when composing a message are: 

• Account: If you have set up one or more email aliases or additional 
From addresses (see Addresses Preferences), use this pop-up menu 
to specify which address will appear as the From address in the 
message you’re sending. 

• Attach a File: To attach a file to your message, click the attach  
icon, navigate to and select the file on your computer, and click 
Choose. Repeat for any additional files you want to attach—up to a 
maximum of 20 MB worth of files. To remove a file you’ve chosen, 
click its delete  icon. 

• Save as Draft: If you’re not ready to send a message yet but want 
to save what you’ve written so far, click save-as-draft  icon. The 
message is saved in your Drafts folder. 

• Styles: A recent addition to MobileMe Mail is support for styled 
text, including your choice of fonts, sizes, and colors; bold, italic, 
and underline styles; left, center, and right alignment; bulleted 
and numbered lists; indenting; and clickable links. Use the self-
explanatory controls on the format bar (Figure 13), immediately 
above the message area, to apply any of these styles. 

 
Figure 13: The format bar contains controls for adding styles to your 
outgoing email messages. 
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Work with Folders on the Server 
MobileMe email is based on IMAP, which means it can store email 
messages on the server in any number of user-configured mail folders. 
The folder list appears in the sidebar. To modify this list, you can do 
any of the following: 

• Add a folder: Click the plus  icon next to Folders in the sidebar, 
type a name for the new folder, and press Return. Click the new 
folder to view it. To create a new subfolder within an existing folder, 
first select the existing folder and then click the plus  icon. 

• Rename a folder: Double-click the folder name, type a new 
name, and press Return. (Changes to folder names may not appear 
immediately in Mail or other email programs; quitting and re-
starting those programs will usually resynchronize the folder list.) 

• Delete a folder: Select the folder and press Delete; then click 
Delete (or press Return) to confirm the deletion. 

• Move a folder: Drag a folder into another folder to make the 
former a subfolder of the latter. To move a subfolder to the top 
level, drag it to the Folders label in the sidebar. 

Note: Although you can move a folder into or out of another fol-
der, you can’t rearrange the order of folders, at any given level, 
by manually dragging or moving them. However, since folders are 
sorted alphabetically, you can customize their order by using a 
little creative renaming. 

• Empty the Trash mailbox: Choose Actions  > Empty Trash. 
 

Configure MobileMe Mail Preferences 
When you choose Actions  > Preferences, MobileMe presents five 
sets of preferences: General, Addresses, Composing, Rules, and 
Vacation. Click one of those icons to display a view containing that 
category of settings. When you’re finished modifying preferences (in 
one or more views), click the Done button at the bottom of the view. 
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General Preferences 
Let’s first look at the Preferences shown in the General pane (Figure 14). 

 
Figure 14: Adjust general preferences for Mail using this pane. 

Viewing: 
• Load Images in HTML Messages: By default this box is un-

checked, so images in an HTML message won’t appear unless you 
click the Load Images button at the top of the message. This setting 
may prevent spammers from detecting that their junk mail reached 
you. To display images automatically, check the box. 

• Show All Folders at Login: When this box is checked, your list 
of user-created mail folders is expanded, showing all subfolders, 
when you sign in; if unchecked, the list is collapsed at sign-in. 
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Forwarding: 
• Forward My Email To: MobileMe can forward all your incoming 

email to another (non-MobileMe) address, if you wish. This can be 
useful, for example, if you want to maintain multiple email address 
but check only one account, or if you want someone else to get 
copies of all your email. 

To turn on forwarding, check this box and fill in an email address. 
(You cannot forward your email to another me.com or mac.com 
address.) If Delete Messages After Forwarding is unchecked, 
incoming messages remain in your MobileMe Inbox (and count 
toward your storage quota) even when forwarded; if this option is 
checked, messages are deleted immediately after being forwarded. 

Mailboxes: 
• Save Sent Messages In: When this box is checked, MobileMe 

Mail saves copies of all outgoing messages into the folder you 
choose from the pop-up menu—typically Sent. 

• Move Deleted Messages To: When this box is checked, mes-
sages you delete are moved to the folder you choose from the pop-
up menu—typically Trash. (MobileMe Mail automatically deletes 
messages in your Trash mailbox 30 days after they’re moved there.) 
When this box is unchecked, deleted messages are removed from 
the server immediately and permanently. 

Addresses Preferences 
The Addresses pane (Figure 15) combines several functions, each 
of which gives you the capability to send email from an address other 
than your primary MobileMe email address. And, in the case of aliases 
and POP accounts, these options also let you receive mail in your 
MobileMe Inbox that was sent to an address different from your main 
@me.com or @mac.com address. 

You’ll notice that the instructions for setting up aliases, additional 
From addresses, and POP accounts are quite similar, but I separate 
them here because each has certain aspects that distinguish it from 
the others. 
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Figure 15: Set up aliases, new From addresses, and POP accounts 
in this pane. 

Tip: If you ever want to change the full name or description 
associated with your main MobileMe address, you can do so in the 
Addresses preference pane: simply select the address and make 
the desired changes to the right. 

Aliases 
Your MobileMe account comes with a me.com email address, but you 
can also configure up to five aliases—extra me.com email addresses 
that deliver messages to your main account. For example, since my 
MobileMe member name is jwk, my primary MobileMe address is 
jwk@me.com. But if I wanted a second address that would be more 
obvious and memorable, I could (well, did) set up the alias 
joekissell@me.com. Any mail sent to joekissell@me.com is actually 
delivered to jwk@me.com. 

You can disable these aliases at any time, so if you begin receiving 
unwanted email at an alias address, you can “shut down” that address 
with just a few clicks. 
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To create an email alias, follow these steps: 

1. Click the plus  button at the top of the Addresses list. 

2. Select the Mail Alias radio button and click Next. 

3. In the fields provided, enter the alias you want to use (the portion 
of the address before @me.com) and the name that will appear in 
the From field when you send message using that alias. You can 
optionally choose a color—when using the MobileMe Web site to 
retrieve your email, messages sent to the alias appear with a small 
color label next to the subject so that you can easily distinguish 
them. 

4. Click Next. If your chosen address is already in use by another 
MobileMe member, the site suggests alternatives. Otherwise, it 
shows a green checkmark and displays a message stating that your 
alias was created successfully. Click Done. 

You can repeat this procedure as necessary to add up to five aliases. As 
soon as you’ve set up an alias, any incoming email sent to that address 
goes directly into your MobileMe Inbox. 

When you want to stop receiving email sent to an alias, you can either 
deactivate it or delete it. In either case, any email sent to the alias 
bounces back to its sender. The difference is that if you merely deacti-
vate an alias, you can reactivate it later. If you delete an alias, it’s gone 
forever—neither you nor anyone else can ever choose that email 
address again. Your limit of five aliases applies to both active and 
inactive aliases. If you reach your limit and want to create a new alias, 
you first must delete an existing alias. 

Warning! If you already have five aliases and delete one, MobileMe 
imposes a one-week waiting period before you can create a new one. 
(You can’t get around this by deleting more than one of your aliases, 
either.) This is a security measure to prevent unscrupulous users from 
hoarding aliases or using a string of aliases to send out spam. 

To deactivate an alias, select it in the Addresses list and then uncheck 
the Enable Alias box to the right; to reactivate the alias, check the box. 

To delete an alias permanently, select it in the Addresses list and then 
click the minus  button; click Delete to confirm. 



50 

When sending outgoing messages, you may want to use an alias as 
the From address so that your main address remains private and 
replies go to the alias address. To use an alias when sending outgoing 
email, choose it from the From Address pop-up menu in the Compose 
window (Figure 16). (You use the same menu to choose one of any 
additional From addresses or POP accounts, as described next.) 

 
Figure 16: Choose an alias or account from this pop-up menu to use 
it as the From address for this particular outgoing message. 

 

Aliases in Apple Mail 
Apple’s Mac OS X Mail application works seamlessly with aliases 
you’ve defined on the MobileMe Web site. When sending a mes-
sage with Mail, you can (just as when using the Web interface) 
choose one of your aliases as the From address. To do this, 
choose the alias from the From pop-up menu just below the 
Subject field of the New Message window. 



51 

Extra From Addresses 
You can also configure MobileMe Mail to use, as the From address for 
outgoing messages, the email address associated with one or more 
other email accounts you own. When you do this, the message appears 
to have come from the other address (for example, your work email 
account), and replies go to that address, rather than to your MobileMe 
address. 

To configure an additional From address in MobileMe Mail, follow 
these steps in the Addresses preference pane: 

1. Click the plus  button at the top of the Addresses list. 

2. Select the Send Using External Address radio button and click Next. 

3. Fill in the email address for the other account, your full name, and a 
description (anything that will help you identify the account) in the 
fields provided. Optionally, choose a label color; incoming messages 
sent to this address will have that color label in your Inbox. (This 
comes into play only when you’ve forwarded incoming mail from 
the other account to MobileMe or, in the case of POP accounts, 
when you use MobileMe to check that account.) Click Next. 

4. Enter the SMTP server, port (25, 465, or 587), user name, and 
password that your other account uses for outgoing mail. (If in 
doubt about any of these settings, contact the other account’s 
provider, or review the materials you received when you originally 
set up that account.) Click Next. 

MobileMe Mail verifies your settings. If any problems exist, an error 
message appears, telling you what needs to be corrected. If everything 
was entered correctly, a green check mark appears; click Done, and 
then click Done again to close the Preferences window.  

If you later want to change any of the settings associated with this 
address, return to the Addresses preference pane and select the 
address. You can edit the description, full name, and label color using 
the controls provided; click Edit Address Settings to change other 
settings. To remove an extra From address, select it and click the 
minus  button at the top of the Addresses list. 
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Now that the additional address has been configured, you can choose 
it from the From pop-up menu when composing a new email message. 
When you send the message, MobileMe Mail uses that account’s SMTP 
server. 

POP Accounts 
MobileMe Mail can check one or more POP accounts from other email 
providers or ISPs; messages received to these accounts appear both on 
the MobileMe Web site and in your desktop or mobile email client. In 
the process of setting up a POP account, you also configure its associ-
ated SMTP account, so that you can send mail from that account’s 
address in addition to receiving mail. 

Fully automatic: In a welcome change from earlier behavior, 
MobileMe Mail now checks your POP account(s) automatically in 
the background roughly every 15 minutes—even if you’re not signed 
in to the MobileMe Web site. 

To set up this feature, follow these steps: 

1. Click the plus  button at the top of the Addresses list. 

2. Select the POP Mail radio button and click Next. 

3. Fill in the email address associated with the other account, your 
full name, and a description (anything that will help you identify 
the account) in the fields provided. Optionally, choose a label color; 
incoming messages sent to this address will have that color label 
in your Inbox. Click Next. 

4. Enter the POP server, user name, and password for your POP 
account. (If in doubt about any of these settings, contact the other 
account’s provider, or review the materials you received when you 
originally set up that account.) If you select Leave Messages on 
Server, MobileMe does not delete the messages from the POP server 
after importing them. Click Next. 

5. Enter the SMTP server, port (25, 465, or 587), user name, and 
password that your POP account uses for outgoing mail. (If in 
doubt about any of these settings, contact the other account’s 
provider, or review the materials you received when you originally 
set up that account.) Click Next. 
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MobileMe Mail verifies your settings. If any problems exist, an error 
message appears, telling you what needs to be corrected. If everything 
was entered correctly, a green check mark appears; click Done, and 
then click Done again to close the Preferences window.  

Once you’ve set up your POP account, MobileMe Mail begins checking 
it regularly. However, it may take up to 15 minutes for any existing 
messages from your POP account to appear in MobileMe. 

To modify any of the settings for this account, return to the Addresses 
preference pane and select the address. You can edit the description, 
full name, and label color with the controls provided; click Edit 
Address Settings to change other settings. To remove a POP account, 
select it and click the minus  button at the top of the Addresses list. 

Composing Preferences 
Next up is the Composing pane (Figure 17), with its preferences 
relating to what appears in your outgoing messages. 

 
Figure 17: In this pane, you can configure preferences for compos-
ing outgoing messages. 
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Composing: 
• Include Original Message When Replying: With this box 

checked, every time you reply to a message, the original message is 
quoted (with an attribution line, such as On Wednesday, September 
22, 2010, at 02:11PM, Joe Kissell <jwk@me.com> wrote: and with > 
symbols at the beginning of each line of quoted text). You can 
always edit out all or part of the quoted text before sending the 
message. 

• Show Bcc Field: When selected, a Bcc (blind carbon copy) field 
appears below the Cc field in the message composition window. 

• Encode Outgoing Messages Using Unicode (UTF-8): If 
you send messages using characters that don’t appear in common 
European languages like English, French, Spanish, and German, 
checking this box can help to ensure that your recipients can read 
your messages (as long as they’re using a modern email client). 

Identity: 
• Send New Messages From: If you’ve configured any email 

aliases or extra From addresses, or if you were a .Mac subscriber 
(and therefore have both member-name@mac.com and member-
name@me.com addresses), you choose the default From address 
here. (You can always override this setting for individual messages.) 

• Add a Signature to Your Outbound Mail: A signature is a 
bit of text that appears automatically—assuming you enable this 
option—at the end of each message you compose on the MobileMe 
site (or, in replies, at the end of your reply but before quoted text 
from the original message). This text can include your name, phone 
number, favorite quote, or anything you want every recipient to see. 
Don’t include your life story here; a few lines should be more than 
adequate. 

Note: Signatures you set up in the Mail application don’t sync with 
MobileMe Mail. 

Rules Preferences 
One of the most useful recently added MobileMe features is the 
capability to run server-based rules on incoming messages. Most email 
clients, such as Mail, Entourage, Thunderbird, and Outlook, let you 
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specify rules that look for incoming messages matching certain criteria 
(such as subject or sender) and then apply to those message an action 
(such as moving them to a particular mailbox). Rules in MobileMe 
Mail do much the same thing, but with the advantage that they run as 
soon as a message is received by Apple’s email servers—whether you 
happen to be signed in to MobileMe at the time or not. The next time 
you check your mail—whether on the Web or in your favorite email 
client—the actions associated with the rules will already have been 
taken. 

This is cool for two main reasons. First, if you’re checking your email 
on the Web, you can take advantage of rules to preprocess your mes-
sages, rather than having to face an overflowing Inbox. And second, 
MobileMe Mail’s rules can sort messages before they appear on your 
iPhone, iPad, or iPod touch—which overcomes, to some extent, the 
lack of a rules feature on these devices. 

However, before you get too excited about this capability, I should 
mention that rules in MobileMe Mail are far less powerful than those 
in desktop email clients, and less powerful than in some competing 
Web-based email systems, such as Gmail. MobileMe rules can match 
only From, To, Cc, and Subject fields, and can perform only three 
actions: move the message to a folder, move the message to the trash, 
or forward the message. Even so, something is better than nothing! 

To create a rule, follow these steps: 

1. Choose Actions  > Rules; alternatively, while in the Preferences 
window, click the Rules icon on the toolbar. 

2. From the Add a Rule pop-up menu, choose the action you want this 
rule to perform: Move Messages to a Folder, Move Messages to the 
Trash, or Forward Messages to an Email Address. 

A new, blank rule is created. 

3. From the first pop-up menu, choose which field the rule should 
examine: From, Addressed To (that is, To), That CC (that is, Cc), or 
Whose Subjects Incl. (that is, Subject). 

4. In the next field, enter the text (a name, email address, word, or 
phrase) the rule should look for in the chosen field. 
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5. Provide any required additional details: 

• When the action is moving messages: From the second 
pop-up menu, choose the destination folder. 

• When the action is forwarding messages: In the second 
text field, enter the address to which MobileMe should forward 
the message. 

Your final rule may look something like Figure 18. 

 
Figure 18: Create server-based rules in this preference pane. 

6. Click Save. 

7. Repeat steps 2–6, if desired, to create additional rules. When you’re 
finished, click Done. 

Rules take effect within a few minutes. You can reorder your rules—if 
two or more rules apply to the same message, the one higher in the list 
takes precedence— by dragging rules up or down in the list. 

If you ever want to change a rule, click it in the list to make its fields 
editable. To delete a rule, click it and then click its Delete  icon. 
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Vacation Preferences 
Finally, the Vacation pane (Figure 19) lets you set up an auto-
response, which can be useful if you’re away from your email for a 
while or if you simply want each message to get an immediate reply. 

 
Figure 19: Set up automatic replies in this pane. 

To enable this feature, check the Auto-response box and enter the text 
of the reply. Each email address receives only one auto-reply—if one 
person (or mailing list) emails you a dozen times while autoreply is 
enabled, only the first one of those messages generates a reply. 

Unlike similar features you might set up in your desktop email client, 
auto-response works even if your computer is off (since it runs on 
Apple’s mail server). 

Tip: You can, if you want, forward all your MobileMe email to 
another account and send an autoreply. Using both (particularly 
when Delete Messages After Forwarding is unchecked) can be 
useful for sending automated replies while also forwarding all 
messages to a colleague or family member in case something 
urgent comes up while you’re on vacation or otherwise away. 
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ACCESS MOBILEME MAIL USING 
APPLE MAIL 
Apple’s Mail application, included with every copy of Mac OS X, is 
a full-featured email client that works with virtually any mail server. 
Conversely, although you can use almost any email client (not to 
mention the MobileMe Web site) to fetch your MobileMe email, Mail 
includes a few special features that make it the best way to send and 
receive email using your MobileMe account. 

For starters, Mail offers MobileMe users automatic account setup 
under 10.5 Leopard and later versions of Mac OS X. It also provides 
an easy way to create rules that go far beyond the capabilities provided 
on the MobileMe Web site. It automatically recognizes, and makes 
available, any MobileMe aliases you’ve set up (although not other 
From addresses—you must add those manually). And Mail automati-
cally recognizes your email aliases (see Addresses Preferences, ahead); 
provides a mechanism to sync your account settings, rules, signatures, 
and smart mailboxes between Macs; and gives you ultra-fast Spotlight 
searching that includes the contents of all your email messages, not 
just the headers. 

If you entered your MobileMe member name and password when 
installing (or upgrading) Mac OS X, Mail should already be configured 
to check your MobileMe account. If not (or if you bought a MobileMe 
membership later), you can add your account to Mail as follows: 

1. In Mail, choose Mail > Preferences and click Accounts. 

2. Click the plus  button to add a new email account. 

3. In the fields provided, fill in your Full Name, Email Address 
(member-name@me.com), and Password. Click Continue. 

Assuming your credentials are correct, Mail is now configured to check 
your MobileMe account. 

Tip: To learn much more about Apple Mail, check out my two 
books on the subject: Take Control of Apple Mail in Snow Leopard 
and Take Control of Spam with Apple Mail. 

http://www.takecontrolbooks.com/snow-leopard-apple-mail?pt=INTERNAL
http://www.takecontrolbooks.com/spam-apple-mail?pt=INTERNAL
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Using POP with MobileMe 
By default, Mac OS X’s Mail application uses the IMAP protocol to 
retrieve your email, keeping messages on the server unless you 
specifically choose to save them offline. Although MobileMe can 
also use POP, an older protocol that requires every downloaded 
message be stored on your computer, I strongly recommend 
sticking with IMAP. But if you prefer to access your MobileMe 
email with Mac OS X Mail using POP, set it up as follows: 

1. Choose Mail > Preferences and click Accounts. 

2. Click the plus  button to add a new email account. 

3. In the Add Account screen, enter your name and your full 
MobileMe email address (leave Password blank); uncheck 
the Automatically Set Up Account box that appears; and click 
Continue. 

4. Choose POP from the Account Type pop-up menu. 

5. Enter something descriptive (such as your me.com email 
address) as the Description. 

6. In the Incoming Mail Server field, type mail.me.com. In the 
User Name field, enter your MobileMe member name. Enter 
your password, and then click Continue. 

7. On the next screen, in the Outgoing Mail Server field, type 
smtp.me.com if it is not already displayed. Make sure the Use 
Authentication checkbox is selected. The User Name field and 
Password field should contain the same information as in Step 6 
(and may already be filled in for you). Click Continue. 

8. After Mail verifies your account settings and displays your 
Account Summary, click Create. 

Mail now checks your MobileMe email using POP. 
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ACCESS MOBILEME MAIL 
WITH OTHER EMAIL CLIENTS 
If you’re unsatisfied with the MobileMe webmail interface but can’t 
or don’t want to use Mail under Mac OS X, you can use the email client 
of your choice on any platform, including Windows and Linux. Just set 
up a new account using IMAP (if available) or POP, with these settings: 

• Incoming mail (POP or IMAP) server: mail.me.com 

• User name: Your MobileMe member name 

• Password: Your MobileMe password 

• IMAP or POP Authentication: Use “password” if your email 
client provides multiple options. 

• SSL for incoming mail: Yes, if the client offers the option 

• Outgoing (or SMTP) mail server: smtp.me.com 

• SMTP Authentication: Yes; use “password” if your email client 
provides multiple options 

• SMTP port: 587 

• SSL for outgoing mail: Yes, if the client offers the option 

USE MAIL ON AN iOS DEVICE 
If you have an iPhone, iPad, or iPod touch, chances are it’s already set 
up to receive mail from your MobileMe account. If not, follow these 
steps for a basic configuration: 

1. Go to Settings > Mail, Contacts, Calendars. 

2. Make sure Fetch New Data (just below the Accounts section) is 
set to Push; if not, tap Fetch New Data, tap the switch next to Push 
to turn it on, and then tap the button in the top left corner of the 
screen to return to the main Mail, Contacts, Calendars view. 

3. Tap Add Account, followed by MobileMe. 
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4. In the fields provided, enter your name, email address, password, 
and description (a name for the account—this will appear in Mail’s 
Accounts view). Tap Next. 

5. In the next view, set each item to On or Off, as you prefer. Mail, of 
course, should be On. In most cases, you’ll want the other items to 
be On, too. Tap Done. 

Your MobileMe account now appears in your Accounts list, and begins 
receiving email (and, if enabled, other data) almost immediately. 

Tip: To learn much more about working with email on your iOS 
device, read my book Take Control of Mail on the iPhone and iPod 
touch, iOS 4 Edition. 

 

Addressing a discrepancy: If you set up your iOS device using 
a member-name@me.com address, that’s what will show up as your 
From address when you send mail from that account. If you also have 
an older mac.com email address and want to use that instead (or to 
have it as an option), enter your mac.com address in Step 5 instead 
of your me.com address. If you’ve already set up your device with the 
me.com address, delete your MobileMe account on your iOS device 
and then add it again using the mac.com address. 

http://www.takecontrolbooks.com/ios-4-mail?pt=INTERNAL
http://www.takecontrolbooks.com/ios-4-mail?pt=INTERNAL
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Contacts 
 
Once you’ve followed the steps in Keep Your Data in Sync to 
synchronize your contacts between MobileMe and Address Book 
in Mac OS X or Windows, or Outlook in Windows, you can not only 
sync those contacts easily to another computer or mobile device, but 
also view (and edit) them from any computer on the Internet using 
the MobileMe Contacts application. Naturally, these contacts are 
also available when using the site to send email; see Mail for more 
information. 

 

Changes Ahead? 
In the several months prior to the publication of this book, Apple 
made a series of methodical changes to the capabilities of the 
MobileMe Web site—notably, overhauling Mail, switching to a new 
infrastructure and interface for Calendar, adding significant capa-
bilities to iDisk, and modifying the overall site design.  

The one component that hasn’t yet received a major makeover 
is Contacts, which leads me to suspect it could be next. In the 
event of any big changes from what you see here, click Check for 
Updates on the cover of this ebook to see what’s new and what 
plans we have for future Take Control coverage. 

VIEW CONTACTS 
To access your contacts online, sign in to the MobileMe Web site and 
go to the Contacts application. You should see something resembling 
Figure 20. 
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Figure 20: Using MobileMe Contacts, you can view and edit your 
contacts on the Web. 

Apple designed MobileMe Contacts to look and act very much like 
Address Book under Mac OS X. As such, most of the things you’ll want 
to do will be fairly self-explanatory, but I’ve included a brief overview 
in the pages ahead. 

SEARCH FOR CONTACTS 
Type any portion of a contact’s first or last name or company name 
into the Search field in the toolbar, and matching results appear 
immediately. (Sadly, you can’t search on other contact data.) 

WORK WITH CONTACT GROUPS 
The sidebar lists any standard Address Book groups you may have 
(but not smart groups). You can do the following tasks with groups: 

• Display group contents: Select a group to display just the 
contacts in that group (a contact may be in more than one group). 
Select All in the sidebar to display all your contacts. 

• Add a group: To add a group, click the plus  button at the 
bottom of the sidebar. 
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• Add or remove group members: Drag a contact into a group 
to add it to that group. To remove a contact from a group, first 
select the group and then the contact you want to remove. Press 
the Delete key and then, when the confirmation alert appears, click 
Remove from Group. 

EDIT, ADD, OR DELETE CONTACTS 
Select a contact in the contact list (the column to the immediate right 
of the sidebar) to view its details. You can also do the following with 
individual contacts: 

• Edit a contact: To edit a contact, select it and click the edit  

icon in the toolbar. To add an additional phone number, email 
address, or other item of which there may be more than one, click 
the plus  icon next to the last existing item of that type; to remove 
one of these items, click the minus  icon. To display and edit a 
field that doesn’t appear by default (such as Birthday or Middle 
Name), choose the field name from the Add Field pop-up menu. 
After making any changes, click Save. 

• Add a contact: Click plus  to create a new contact. 

• Delete a contact: Select the contact, and click the Delete  icon. 

PERFORM MORE CONTACT-RELATED TASKS 
The Actions  pop-up menu contains several additional useful 
commands: 

• Email Contact: Select one or more contacts and choose Email 
Contact to create a new MobileMe Mail message pre-addressed 
to the selected contact(s). 

• Print: Select a single contact and choose Print to display that 
contact’s data in a printer-friendly window. (Once that window 
appears, you may have to wait a moment for the Print dialog to 
appear; if it doesn’t, click the Print Contact link.) If you select mul-
tiple contacts (using Shift or Command) before choosing this com-
mand, the print window displays only the first selected contact, but 
all are printed. 
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• Import vCard: Most contact managers can export contacts in 
an industry-standard format called vCard; it’s also common practice 
to distribute one’s own vCard as an email attachment. If you have a 
vCard file containing one or more contacts that you’d like to import 
into MobileMe Contacts, choose Import vCard, click Choose File, 
select the vCard file in the file-navigation dialog, and click Import. 

• Export vCard: To save one or more contacts as a vCard file, select 
the contact(s), choose Export vCard. MobileMe creates the file and 
tells your browser to download it immediately. If you’re doing this 
on a Mac, then (assuming default settings), the downloaded vCard 
opens automatically in Address Book. (This is probably not what 
you want, because the contacts you just exported are presumably 
already in Address Book; if that’s the case, just click Cancel.) 

SET CONTACT PREFERENCES 
Choose Actions  > Preferences to display Contact Preferences. Your 
choices are as follows: 

• Display order: Select either First Name Last Name or Last Name, 
First Name to specify how contact names appear in the list. 

• Sort order: Choose either Last Name or First Name from the Sort 
By pop-up menu to specify the order in which contacts are sorted. 

• Address Layout: Choose a country from this pop-up menu to 
determine how addresses are shown. 

Format options: Unfortunately, you can choose only one layout 
for all your addresses. However, in Address Book in Mac OS X, 
you can choose address formats individually for each contact, and 
the settings you make there also appear in MobileMe Contacts on 
the Web. 

• Automatically Format Phone Numbers: Check this box and 
choose a format from the pop-up menu, and any number you type 
in a phone number field will automatically reformat itself in the 
manner you’ve selected. If your phone numbers will follow a variety 
of formats, leave this box unchecked. 
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Calendar 
 
Back in the .Mac days, you couldn’t edit calendars on the Web, 
and even viewing them was a pain—plus Windows users had no 
calendar features at all. But now, with MobileMe, you can sync 
calendars between iCal on your Mac, Outlook on your Windows 
PC, and the Calendar app on your iOS device—and access those 
calendars on the Web in a fantastic calendar application that looks 
and acts much like Calendar on an iPad. First follow the steps in 
Keep Your Data in Sync, and then read on to find out how to use 
MobileMe Calendar. 

 

The New MobileMe Calendar 
In mid-October 2010, Apple rolled out a new and revised MobileMe 
Calendar application, which is what I describe in this chapter. 

However, please be aware of the following: 

• To use the new Calendar on a Mac, you must be running Mac 
OS X Snow Leopard 10.6.4 or later; on an iPad, you need iOS 
3.2 or later, and on an iPhone or iPod touch, you need iOS 4.1 
or later. 

• Assuming you meet the system requirements, you must com-
plete a few easy steps to switch to the new Calendar—it’s not 
automatic. Sign in to the MobileMe Web site, go to the Calendar 
application, and click the Upgrade Now link in the lower-left 
corner. Then follow Apple’s onscreen instructions. (If you join 
MobileMe as a new user after October 1, 2010, you can skip 
these extra steps.) 

• Apple provides a helpful FAQ about the new and improved 
Calendar at http://support.apple.com/kb/HT4037. 

WORK WITH EVENTS 
To see your calendars on the Web, sign in to the MobileMe Web site 
and go to the Calendar application. (The date on the icon changes 
to match the current date!) You’ll see something like Figure 21. 

http://support.apple.com/kb/HT4037


67 

 
Figure 21: MobileMe Calendar’s Week view. 

Choose a Calendar View 
By default, Calendar shows whichever view you used last. Click the 
Day, Week, Month, or List button in the toolbar to switch your view. 

Navigate to Another Date 
Click previous  or next  on the timeline at the bottom of the win-
dow to move to the previous or next day, week, or month; you can also 
click a specific date on the timeline to jump directly to it. After moving 
to another day, week, or month, click the Today button in the lower-
left corner of the window to jump back to the current date. 

To jump to a date that’s more than a few clicks away, choose Actions 
 > Go to Date, enter a date, and click OK. 

Use the Notification Box 
A recently added feature is a notification box, which provides a quick 
way to see event invitations you’ve received from other people, as well 
as responses to invitations you’ve sent. If you have any notifications, 
the Show Notifications  button in the toolbar displays a badge with 
the number of waiting notifications; click the button to display them. 
Then, click Accept, Decline, or Maybe to respond to an event invita-
tion; click OK to acknowledge an invitation response; or click Join 
Calendar or Don’t Join to respond to a calendar-sharing invitation. 
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Once you’ve acknowledged a notification in any way, it disappears 
from the notification box. 

If you decline an invitation to an event that someone else has created, 
that event won’t show up on your calendar unless you choose Actions 

 > Show Declined Events. 

ADD, EDIT, OR DELETE EVENTS 
MobileMe Calendar makes it easy to create and modify events. 

Add an Event 
Select a calendar name in the sidebar; then do any of the following to 
create an event in that calendar: 

• In Day, Week, or List view, drag your pointer across a range of time 
to create an event for that time range. To create a multi-day event, 
drag across a range of dates in the hourly portion (not the All-Day 
section) of Week view. 

• In Month view, double-click in the day on which you want to 
schedule the event. 

• In any view, click the plus  icon in the lower-right corner of the 
window, or choose Actions  > New Event. 

• To create an all-day event, double-click in the All-Day Events or All 
Day section in Day or Week view, respectively. 

Set Event Details 
In the pop-up window that appears when you create an event, enter or 
edit any or all of the following information: 

• Title: The name of the event. 

• Location: Where the event will take place. 

• All-Day: Check this to create an all-day event, regardless of how 
you initially created the event. 

• From and To: Set the event’s start and end date and time. 

• Time Zone: Choose the event’s time zone (if you’ve enabled that 
feature—see Set Calendar Preferences). 
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• Repeat: For events that recur on a regular schedule (for example, 
weekly or monthly), choose the interval from this pop-up menu, or 
choose Custom and enter a different interval. 

• Calendar: Newly created events are initially set to the calendar 
that was selected when you created them, but you can switch them 
to a different calendar using this pop-up menu. 

• Invitees: Enter a name or email address to invite someone else 
invitation to the event. As you type a portion of a name or address, 
Calendar looks for matching contacts in your MobileMe address 
book and offers a pop-up menu of possible matches. Select a contact 
from this list (with the mouse, or by pressing the arrow keys and 
then the Return key) to accept it, or keep typing. Each time you add 
an invitee, another field appears; press Tab and repeat the proce-
dure to add more invitees. 

After adding an invitee, click the person’s name to display a pop-up 
menu with options such as Edit and Remove. 

When an invitee is a MobileMe member, their invitation appears 
in Calendar’s notification box on the MobileMe Web site, as well as 
in iCal and in the Calendar app on an iOS device. For other invitees, 
invitation email messages include buttons (or links) for Accept, 
Decline, and Maybe. After clicking one of these, the invitee sees 
a confirmation Web page with a downloadable .ics file that can be 
used to add the event to iCal or Outlook. In addition, the event on 
your own calendar is updated with icons reflecting each invitee’s 
status, and any responses also appear in your notification box (see 
Use the Notification Box, slightly earlier in this chapter). 

• Note: To add directions or other details, type them in this field. 

Click OK after making any changes, or click Cancel to cancel creation 
of the event. If the event has any invitees, a Send button replaces the 
OK button; click Send to accept the changes and send the invitation(s). 

Change Event Details 
You can modify any aspect of an event after you’ve created it. Double-
click an event to display a pop-up window in which you can change any 
of the event’s details.  



70 

Move an Event 
To reschedule an event, drag it on the calendar—moving it to the 
desired date and time. 

Change an Event’s Duration 
To change just the start or end time of an event, drag the top or bottom 
border of an event on the calendar. 

Delete an Event 
To remove an event from your calendar completely, select the event 
and press Delete or Backspace. 

Note: In MobileMe Calendar, you can’t set or modify alarms for 
events. To do this, use iCal (on a Mac), Outlook (on Windows), or 
Calendar (on an iOS device). 

WORK WITH TO-DO ITEMS 
MobileMe Calendar can manage to-do items, too. To display your To 
Do list—it appears on the right of the window (Figure 22)—choose 
Actions  > Show To Do List; to hide it, choose Hide To Do List. 

 
Figure 22: The To Do list can appear within the Calendar window 
(on the right-hand side). 
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To change the way your to-do items are sorted, click the pop-up menu 
at the bottom of the list (shown in Figure 22 as “Sort by Priority”) and 
choose one of the following: Sort by Due Date, Sort by Priority, Sort by 
Title, or Sort by Calendar. 

You can also do the following with to-do items: 

• Create a new to-do item: Select a calendar and choose Actions 
 > New To Do. Or, if the To Do list is visible, click the plus  

button at the top of the list. Enter any desired details (title, priority, 
due date, calendar, and note), and click OK. 

• Modify a to-do item: Double-click an item in the list to display 
a pop-up window where you can change its title; mark it as com-
pleted; change its priority; add a due date; change which calendar 
it’s in; or add a note. 

• Mark an item as completed: Check the box next to it in the list. 

• Delete a to-do item: Select a to-do item and press Delete or 
Backspace to delete it. 

MANAGE YOUR CALENDARS 
In addition to working with events and to-do items, you can also 
manage your calendars themselves in MobileMe Calendar. The 
following are the activities you can perform: 

• Show or Hide the Calendars List: You can hide the left-hand 
sidebar—containing the Calendars list—by clicking the Show 
Calendars  button on the toolbar. Click the button again to 
show the sidebar. If you have only one calendar, leaving the list 
hidden can save valuable screen space, but if you use more than one 
calendar, it’s best to leave the list visible. 

• Create a new calendar: Double-click an empty space in the 
Calendars list, or click Edit at the top of the Calendars list followed 
by the plus  button. Type a name for the new calendar and press 
Return or Enter. 

• Rename a calendar: Double-click the calendar name in the 
Calendars list, edit the name, and press Return or Enter. 



72 

• Delete a calendar: Click Edit at the top of the Calendars list, and 
then click the Delete  icon next to the calendar you want to delete. 
Then click Done. 

• Change a calendar’s color: Click Edit at the top of the Calendars 
list, click the colored dot next to the calendar you want to change, 
and click on a new color. Then click Done. 

• Reorganize calendars: Drag a calendar up or down in the 
sidebar to change its position in the list relative to other calendars. 

• Hide a calendar: To disable display of a calendar’s events without 
deleting it, uncheck the box next to it in the sidebar. 

SHARE CALENDARS 
A recent and significant change to MobileMe Calendar is the capability 
to share any calendar, either publicly or privately, using the industry-
standard CalDAV protocol. When you share a calendar privately, you 
can assign read-only or read-write privileges on a per-user basis. This 
mechanism finally makes it practical for families, teams, coworkers, 
and other groups to use MobileMe for calendars that apply to multiple 
people—without jumping through lots of hoops or buying extra soft-
ware. Shared calendars can be viewed in MobileMe Calendar, Mac OS 
X’s iCal, or Microsoft Outlook, or on any iOS device. 

Activate Sharing 
To share a calendar, click the Share  icon by the calendar’s name 
in the sidebar. In the pop-up window that appears, do one of the 
following: 

Share a calendar privately: 
To share a calendar privately—meaning with only the specific people 
you choose—continue with these steps: 

1. Select the Private Calendar radio button. 

2. In the Add Person field, enter a person’s name or email address; 
Calendar looks for matching contacts in your MobileMe address 
book and offers a pop-up menu of possible matches. Select a contact 
from this list (with the mouse, or by pressing the arrow keys and 
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then the Return key) to accept it, or just keep typing to manually 
complete the address. 

Members only: The people with whom you share private calen-
dars must be MobileMe members, and to get full functionality, they 
must also be using the new Calendar. 

3. To permit the person to both view and change the calendar, choose 
View & Edit (the default) from the pop-up menu that appears beside 
their name. To give the person read-only access, choose View Only. 

Only you: You, the calendar’s owner, are the only person who 
can give someone else the right to view and/or edit it. The people 
to whom you grant permission can’t extend that right to others. 

4. Repeat steps 2 and 3 to add more users, if you wish. 

5. When you’re finished adding users, click Share. A confirmation 
message appears, stating that your calendar has been shared. 
MobileMe also sends notifications to the users you added. 

6. If you gave anyone else permission to edit the calendar, optionally 
check Email Me When This Calendar Is Changed. With this box 
checked, when someone other than you makes a change, MobileMe 
sends you a notice by email. 

7. Click OK. 

The Share icon changes to green  to show that the calendar is 
actively being shared. 

Share a calendar publicly: 
To share a calendar publicly, such that anyone who knows its address 
can view it (but not make changes), continue with these steps: 

1. Select the Public Calendar radio button. 

2. Click Share. A confirmation message appears, stating that your 
calendar has been shared, and displaying the URL at which the 
calendar can be found. 

3. Click OK to dismiss the pop-up window. Or, optionally, to email 
a link to this calendar, click Email Link. Enter one or more email 
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addresses and, if you like, modify the default message and/or check 
the Send Me a Copy of the Invitation box. Click Send. 

The Share icon changes to green  to show that the calendar is 
actively being shared. 

Modify or Stop Sharing 
To change the settings for a shared calendar, click its Share  icon. 
Then do one of the following: 

• To add a user, type that person’s address into the Add Person field. 

• To delete a user, click the Delete  icon next to that user’s name. 

• To change a user’s permissions, choose View & Edit or View Only 
from that person’s pop-up menu. 

• To resend an invitation to a shared calendar, click Resend Calendar 
Invitations, select the users to whom you want to resend invitations, 
and click OK. 

• To stop sharing the calendar, click Stop Sharing. In the 
confirmation dialog that appears, optionally check Send Email That 
This Calendar Is No Longer Shared to alert those currently sharing 
the calendar that it’s no longer available. (This option is applicable 
only to private calendars.) Then click Stop Sharing again. 

SET CALENDAR PREFERENCES 
MobileMe Calendar’s preferences are similar to those in iCal. To adjust 
your preferences, choose Actions  > Preferences, and then click 
either General or Advanced to display the corresponding set of options. 
After making any changes to your preferences, click Save. 

General Preferences 
The following options appear in the General view: 

Appearance: 
• Days per Week: Choose 7 (the default) to display all days, or 5 to 

display only Monday through Friday. 

• Start Week On: Choose which day of the week should appear in 
the first column. (In North America, the most common choice is 
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Sunday; in Europe, Monday is more usual. But you can choose any 
day at all.) 

Note: All these appearance-related options affect the way your 
calendars are displayed, but not their contents. 

• Show __ Hours at a Time: You can “stretch” or “shrink” 
Calendar’s display in Day and Week views to show more or fewer 
hours at a time (in other words, without needing to scroll) by 
choosing a number from this menu. 

• Show Birthdays Calendar: If you check this box, Calendar 
displays a new calendar called birthdays, based on what you’ve 
entered in the Birthday field of people in your Contacts list. 

Formats: 
• Date Format: Choose the order in which you prefer day (DD), 

month (MM), and year (YYYY) to appear. 

• Time Format: Choose between 12-hour and 24-hour time. 

• Date Separator: Choose which character you want to appear 
between days, months, and years in dates. 

• Time Separator: Choose a colon (:) or period (.) to appear 
between hours, minutes, and seconds in time displays. 

Advanced Preferences 
The Advanced preference pane contains a variety of settings that aren’t 
so much advanced as miscellaneous. 

Time Zone: 
• Enable Time Zone Support: If you check this box, you can 

choose a time zone for Calendar as a whole or for an individual 
event that’s different from the one you’re in. (I find this useful since 
I live in France but frequently schedule calls and online meetings 
with people in North American time zones—I enter the other party’s 
local time zone, and Calendar translates it automatically.) 

To change your own time zone, go to MobileMe’s Account view, and 
then to the Personal Info pane. 
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Old Events & To Do’s: 
In this section, check the boxes and fill in the values as necessary to 
hide (but not delete) older to-do items or calendar events. All the 
choices should be self-explanatory. 

Invitations & Updates: 
• Ask before Sending Changes to Events: When event details 

change, Calendar normally sends an email message to the other 
invitees to inform them of the updated data. However, some 
changes may be trivial and not worth sending—and too many 
changes may annoy recipients. If you check this box, Calendar 
prompts you for permission before sending out updated invitations.  

• Copy Sent Invitations & Updates to Sent Mail Folder: If this 
box is unchecked, invitations to events don’t appear in Mail’s Sent 
mailbox, even though they’re sent via MobileMe Mail. If you want to 
keep a copy of the sent invitations, check this box. 

Performance & Security: 
• Keep a Copy of My Calendar on This Computer for Faster 

Performance & Offline Access: Using a capability of HTML 5, 
MobileMe Calendar can cache your calendar data in your browser. 
As the notice in the Preferences window says, you should not turn 
this feature on if you’re using a shared or public computer. 
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Gallery 
 
MobileMe Gallery is an elegant way to display photos and videos 
on a Web page or on an Apple TV—and even enable your friends 
to upload their own content. Not only do you get a beautiful end 
result, you get it much more easily than with earlier methods of 
creating Web pages. 

UNDERSTAND GALLERY 
Back in the old days—you know, before late 2007—putting photos 
or movies on the Web typically meant creating a Web page with static 
thumbnails of each item; clicking a thumbnail displayed a larger 
image. (That’s still the basic process that Apple’s iWeb, part of iLife, 
normally uses.) Although it was possible to get quite a bit fancier, 
Apple raised the bar considerably with Web Gallery, which enabled 
users to easily create a richer and more beautiful display of media 
on the Web. Then, in less than a year, Web Gallery morphed into 
MobileMe Gallery—the same thing, only better, because now you can 
create and edit Gallery albums directly on the Web, even if you don’t 
have the latest version of iLife, or are using someone else’s computer. 

Gallery has two faces: the public face (what your friends and family 
see when they visit your site) and the private face (what you see on 
the Web when creating or editing a site). I describe the public side 
of Gallery next; a bit later, I describe the two ways to create a Gallery 
album: Create a Gallery Album on the Web or Create a Gallery with 
iLife. 

A published album in Gallery offers all of the following: 

For photos and movies shared from iPhoto or on the Web: 
You have a choice of four views: 

• A grid of dynamically resizable thumbnails. 

• A “mosaic” view (Figure 23), in which thumbnails appear on the 
side of the window, and the selected image appears at a larger size. 
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Figure 23: In Gallery’s mosaic view, you see resizable thumbnails of 
all your images next to a large image of the selected photo. 

• A “carousel” view (Figure 24), somewhat reminiscent of Mac 
OS X’s Cover Flow view, in which you use a slider to cycle through 
images in a virtual circle, with the front image shown at the largest 
size. 

Adjust to taste: In both grid and mosaic views, you can drag 
a slider at the bottom of the page to grow or shrink the images in 
real time—much like in iPhoto. You can also, in any view, adjust 
the background to black, white, light gray, or dark gray. 

• A slideshow view, in which the images expand to occupy most of 
your screen. 
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In addition, several items are available in every view: 

• Information about each photo or movie, including its dimensions, 
the date it was taken, and details about the camera and exposure. 

 
Figure 24: Carousel view puts your photos in a virtual circle. 

• Optionally, controls that let anyone—or just selected people (more 
on that in a bit)—upload new photos to your Gallery via the Web or 
by email, or download high-resolution copies of your photos. 

iOS shortcut: With an iOS device, you can add a photo (and, 
with an iPhone 3GS or later, a video) to your own Gallery easily. 
In the camera roll (on an iPhone) or the Saved Photos album (on 
an iPad or iPod touch), find a photo or video and tap the arrow 
icon. Tap Send to MobileMe, tap a Gallery name, optionally 
change the subject, and tap Publish.  
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More than one account? If you have more than one MobileMe 
account set up on your iOS device, the one that appears earliest in 
the list is the one used for Gallery uploads. To learn how to change 
this, read the following post at MacOSXHints.com: 
http://www.macosxhints.com/article.php?story=2009062609001
1335. 

• The option to include multiple albums (collections of photos and 
movies) in your Gallery, each with different settings. 

For movies shared from iMovie: 
• A player (Figure 25) that lets you view the movie in up to five 

different sizes, including an almost-full-screen view. 

• Optionally, a control that lets anyone—or just selected people—
download high-resolution copies of your movies. 

 
Figure 25: Your movies look something like this in a gallery. 

http://www.macosxhints.com/article.php?story=20090626090011335
http://www.macosxhints.com/article.php?story=20090626090011335
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For all Galleries: 
• A Subscribe link readers can use to view your Gallery in any RSS-

capable application, such as Safari, Mail, or a dedicated RSS reader; 
as you add new content to the Gallery, the RSS feed updates auto-
matically. You can subscribe either to a particular album, or to an 
entire Gallery (including both photos and movies). 

• A Tell a Friend link anyone can use to email others with the URL for 
any album or movie in your Gallery. 

• If you have an Apple TV, you can connect to a Gallery (yours or 
someone else’s) to view its photos and movies directly on your TV. 

Note: If you created a Gallery in the gallery.mac.com domain 
under .Mac, the existing URL still works, but that Gallery can also 
be reached at the corresponding gallery.me.com URL. 

Now that you’ve seen what Gallery can do, it’s time to create your own. 
I cover two methods ahead: first, the “old” way (using iLife), and then 
the newer way (Create a Gallery Album on the Web). 

CREATE A GALLERY WITH iLIFE 
iPhoto and iMovie (plus Aperture 2 or later—not part of iLife) let you 
share their content directly on your MobileMe Web site. Meanwhile, 
iWeb lets you insert on any page a dynamic preview of an existing 
Gallery. 

Share Photos and Movies with iPhoto 
To put photos and movies from iPhoto into your Gallery, do this: 

1. Select one or more photos or movies, or an entire album. 

2. Choose Share > MobileMe Gallery. 

In iPhoto ’11, a pop-up window appears displaying your existing 
gallery names (so you can add items to a gallery). But, for now, click 
New Album to create a new gallery. (iPhoto ’09 assumes you’re 
creating a new gallery, and doesn’t display this window.) 

A dialog (Figure 26) appears. 
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Figure 26: The options here allow you to enable or disable a variety 
of Gallery features and to control access to your photos. 

3. Select the options you want to use in publishing this album: 

(You can change these later by selecting the album and clicking 
the Settings button.) 

• Album Viewable by: Choose Everyone to make your album 
public. Choose Only Me to restrict the album to yourself—that is, 
you’ll need your MobileMe member name and password to view 
it. Choose Edit Names and Passwords to configure user names 
and passwords for individuals you want to be able to access some 
or all of your albums; then, after adding someone, choose that 
person’s name from this pop-up menu. 

• (Allow) Downloading of photos or entire album: With 
this box checked, the Download icon in your Gallery (as well as 
download buttons for individual photos) will be enabled. When 
someone clicks the download icon for an individual photo, the 
site sends a high-resolution photo as an immediate download. 
Clicking the Download icon for the whole album causes the site 
to compress all the photos (again, at full resolution) into a ZIP 
archive, which a user can then download with one click. 
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• (Allow) Uploading of photos via web browser: To allow 
people who view your album to add photos or movies to it—
which is useful for albums of events at which multiple people 
took pictures—check this box. Then the Upload icon in your 
Gallery will be enabled; a user can click it and, after entering a 
name and email address, as well as typing text from an image to 
ensure the user is human, select one or more photos to upload. 

• (Allow) Adding of photos via email: When checked, anyone 
can send photos, as attachments, to a special email address to 
add them to this album in your Gallery. This address appears 
in the top-right corner of the iPhoto window when the album 
is selected in the iPhoto sidebar (under MobileMe Gallery). 

• (Show) Photo titles: Check this box to display the titles of 
your photos (as in iPhoto) in your Gallery. Note that regardless 
of this setting, titles don’t appear in every view. 

• (Show) Email address for uploading photos: If you’ve 
enabled adding of photos via email, check this box to display 
the email address for submitting photos when someone clicks 
the Send to Album icon in your Gallery. Otherwise, the address 
appears only in iPhoto; you’ll need to manually provide it to 
those people you want to be able to add photos. 

4. For additional options, click Show Advanced: 

• Hide Album on my Gallery Page: Check this box to prevent 
this album from being listed in your main Gallery page; this 
means only people who know the album’s direct URL can visit it. 

• Download Quality: If you’ve allowed downloading, this menu 
lets you choose whether to share Optimized (smaller) or Actual 
Size (larger) photos. This option does not apply to movies. 

5. Click Publish. iPhoto uploads your photos and/or movies to the 
MobileMe Web site. When it’s finished, you can visit the gallery by 
clicking the arrow  button (in iPhoto ’11) or the URL at the top of 
the window (in iPhoto ’09). 

To see all the albums in your Gallery in iPhoto ’11, click your name 
under Web in the iPhoto sidebar. In iPhoto ’09, the albums appear 
individually in the iPhoto sidebar, under MobileMe Gallery.  
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You can edit the contents of these albums just like any other album; 
deleting a MobileMe Gallery album in iPhoto also deletes it from the 
MobileMe site. (To delete a MobileMe Gallery album in iPhoto ’11, first 
select your name under Web in the sidebar. Then right-click [Control-
click] on the album in the main part of the window and choose Delete 
Album from the contextual menu.) 

Sharing Photos with Aperture 
Aperture 2 and later, like iPhoto, lets you publish sets of photos to 
your Gallery with just a few clicks. Follow these steps: 

1. Select an album or some individual images. 

2. Choose File > New From Selection > MobileMe Gallery. If 
you had an album selected, Aperture asks whether you want 
to publish just one image or all the images from that album. 

3. Enter an album name and description, set the other options, 
and click Publish. 

Your photos now appear in your Gallery. 
 

Share Movies with iMovie 
Sending your movies directly to a MobileMe Gallery is a piece of cake 
in iMovie. It’s even easier, in some respects, than sharing photos with 
iPhoto, plus you have more choices when it comes to movie sizes.  

To share a movie, follow these steps: 

1. Select the project you want to share from your Project Library. 

2. Choose Share > MobileMe Gallery.  

A dialog appears (Figure 27). 
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Figure 27: In this dialog, choose which movie size(s) you want to 
appear in your Web Gallery and set other publishing options. 

3. Enter a title for your movie and, optionally, a description. 

4. Check the boxes next to the size(s) in which you want your movie 
to be available. (If your source movie has a low resolution to begin 
with, some of the larger options may not be available.) The table 
shows which sizes are the best fits for each device. Position your 
mouse pointer over the “i” icon to the right of each size to view the 
compression settings and estimated size of the file to be uploaded. 

Four sizes fit all: The more sizes you choose, the longer it will 
take for iMovie to upload those files—and the more space they’ll 
occupy on your iDisk. Choose the combination you think best 
reflects how people will want to view your movie, taking into 
account how much free space you have on your iDisk. 

5. Optionally, restrict who can view your movie, or keep its location 
private, in the same way as for iPhoto photos (see Steps 3 and 4 in 
Share Photos and Movies with iPhoto, earlier). 
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6. To show a download icon for this movie in your Gallery, check Allow 
Movie to Be Downloaded (the default). This lets visitors to your site 
download the medium or large version of this movie as a separate, 
stand-alone file, rather than merely viewing it on the Web. 

7. Click Publish. iMovie uploads your movie file(s) and then presents 
a dialog with the URL for this movie in your Gallery. Click OK to 
dismiss this dialog, click Tell a Friend to send the URL to someone 
by email, or click View to open the page in your default browser. 

To go to your published movie in a browser (or tell someone else about 
it), you need to be in edit mode—in the Project Library, select a project 
and click Edit Project, or double-click the project. Then, in iMovie ’11, 
you’ll see a MobileMe pop-up menu next to the words “Shared to” at 
the top of the iMovie Project pane; the menu’s contents include Visit 
and Tell a Friend. (In iMovie ’09, you’ll see icons to Tell a Friend  or 
Visit  your site.)  

If you later change the movie and want the changes to appear on the 
Web, choose Share > Re-publish to MobileMe Gallery. (When you do 
this, you can change most options about how the movie is shared, but 
not which sizes are shared; to do that, remove the movie from your 
Gallery and publish it again.)  

To remove (or unpublish) a movie from your Gallery without deleting 
it from iMovie, choose (in iMovie ’11) Share > Remove from > 
MobileMe Gallery or (in iMovie ’09) Share > Remove from MobileMe 
Gallery and follow the onscreen instructions. 

Add a Gallery to iWeb 
If you have an existing MobileMe Gallery, you can insert on any page 
of an iWeb site a dynamic thumbnail link to that gallery. To do this, 
choose an album or movie from the Insert > Widget > MobileMe 
Gallery submenu.  

A thumbnail (Figure 28) appears on the page; it can be moved but 
not resized, despite the handles on the corners. 
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Figure 28: A Gallery thumbnail as it appears on an iWeb page. 

Like other thumbnails in Gallery, this thumbnail displays a continuous 
mini slide show of the photos in your gallery, and as you hover your 
mouse over it, the picture changes depending on your position—as 
though all your photos are arranged in an invisible grid below the sur-
face. If you click on the main portion of the thumbnail, a new window 
or tab opens with that photograph showing; click the title or the right 
arrow  icon to visit the main album page. 

For movies from iMovie, a larger thumbnail displays a single frame. 
Click the play icon to play the movie in place, or, as with photo albums, 
click the title or the right arrow  icon to visit the main album page. 

CREATE A GALLERY ALBUM ON THE WEB 
Even without iLife, you can create a Gallery album at www.me.com; 
you can also edit or delete an album created with iPhoto or iMovie. 
To get started, sign in to the MobileMe Web site and go to the Gallery 
application. The sidebar lists your existing Gallery-published albums 
and movies, if any. Select an album or movie to view its contents to the 
right. 

To add an album, click the plus  button at the bottom of the sidebar. 
In the dialog that appears, enter a name and select the other options 
you want, most of which are identical to the ones mentioned earlier 
in Share Photos and Movies with iPhoto. You can’t adjust download 
quality as you can in iPhoto, but you have one additional option: 
choose iPhoto or Aperture from the Syncs With pop-up menu to tell 
MobileMe which application the photos you upload should be synced 
with. Click Create. 
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Add Media to an Album 
To upload files, follow these steps: 

1. With the new album selected, click the big Upload icon in the 
middle of the window (if no files have been uploaded yet) or the 
upload  icon in the toolbar. 

2. Click Choose and navigate to the files you want. (To select multiple 
contiguous files, Shift-click them; to select multiple noncontiguous 
files, Command-click them.) Then click Select. 

3. To upload more files (even if an upload is in progress), click Add 
More and repeat Step 2; when you’re finished, click Done. 

Selected shorts: Movies you upload in Gallery’s Web interface 
can go only into albums; you can’t get stand-alone movie views 
(with a choice of resolutions) as you can when using iMovie. 

Edit an Album 
You can make a variety of changes to an album after adding photos 
or movies (including albums created with iPhoto): 

• Rotate a photo: To rotate a selected photo counterclockwise, 
click the rotate counterclockwise  icon. To rotate a photo 
clockwise, press Option and click the same icon, which changes to 
the rotate clockwise  orientation. 

• Set the key photo: To set the photo that appears on thumbnails, 
select it and choose Set Key Photo from the Actions  pop-up 
menu. 

• Rearrange photos: Drag a photo to a new location to move it. 

• Adjust album settings: Click the adjust  icon in the toolbar 
to display the same dialog you saw when creating the album. (The 
options are more limited when viewing a movie added in iMovie.) 

• Delete an album: To delete an album, select My Gallery in the 
sidebar and then select the album, or click the name of the album 
in the sidebar; then click the Trash  icon in the toolbar. 

• Hide footer: Choose Actions  > Auto-hide Footer to hide the 
footer (which contains the size slider) until the mouse pointer nears 
the bottom of the window. (This setting applies only while editing.) 
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• Reorder albums: Drag an album in the sidebar list to reorder it. 

• Visit a public Gallery: To see the public version of a Gallery, click 
the URL near the right side of the toolbar. 

USE THE MOBILEME GALLERY APP 
Any iOS device can upload media to a MobileMe Gallery without 
additional software, but viewing galleries in Safari on a pocket-sized 
device is less impressive than viewing them on a device with a larger 
screen. As a way of improving the experience of viewing galleries on 
small screens, Apple offers a free MobileMe Gallery app for the iPad, 
iPhone, and iPod touch. 

This app lets you view galleries (your own or someone else’s), use 
familiar flick and pinch gestures to navigate and resize the media, 
respectively, and email links to photos or videos. It also caches Gallery 
photos and videos so that you can view them even without an Internet 
connection. 

http://itunes.apple.com/us/app/mobileme-gallery/id350223710?mt=8
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iDisk 
 
Your iDisk is like an extra drive that provides 20 GB of storage 
(5 GB for Family Members in a MobileMe Family Pack), but this 
virtual drive is located on Apple’s servers. You can use it to store 
anything you want, and you can access it from nearly any computer. 
By putting items in your iDisk’s Public folder, you can also make 
them available to others (with optional password protection). 
Because you share that space between your MobileMe email account 
and your iDisk, the amount of space you’ve designated for email 
storage is subtracted from the total available for other files (see 
Divide Space between Files and Email). 

Although 20 GB is a fair amount of storage, you can quickly fill 
it with photos, videos, Web pages, and other files you want to store 
online. Even if you purchase extra capacity (consult Buy More 
Space), you may find that it’s too little; all those files—especially 
digital media—can take up a huge amount of space. In addition, 
iDisk access is often slow (even as network servers go), making it 
less than ideal for transferring large amounts of data. 

These can be serious limitations, but the key to effective iDisk use 
is to concentrate on its strengths. Its optimal uses are: 

• Providing remote access to important files—using your iDisk 
instead of a USB flash drive or a CD/DVD to make files available 
to yourself when away from your main computer. 

• Synchronizing information between two or more Macs (or 
making that information available via the Web). 

• Publishing Web sites and blogs, and using Gallery for sharing 
photos and movies. 

• Providing a secondary offsite backup for key files. 

• Making large files available to other people. 

These are my opinions, of course; your mileage may vary. But keep 
these ideas in mind as you read more about iDisk’s features. 
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EXPLORE YOUR iDISK 
To view the contents of your iDisk, sign in to the MobileMe Web site 
and go to the iDisk application; or, in Mac OS X, click the iDisk icon in 
the sidebar of any Finder window. (For other ways to access your 
iDisk, read Access an iDisk, ahead.) 

You’ll notice that your iDisk contains a number of folders. They’re all 
there for good reasons, though some are holdovers from .Mac and are 
seldom used. I’m not going to enumerate every folder, because many of 
them are irrelevant (and you should never attempt to rename or delete 
any folder Apple created). Here are the folders you should care about: 

• Backup: If you use Apple’s Backup utility (see Back Up Your Files), 
it’ll store its files here. Otherwise, leave this folder alone—if you 
want to back up files to your iDisk using another program, create 
another folder (at the top level or inside Documents). 

• Documents: In general, any files you want to access via the Web 
or from another computer—but not give anyone else access to—
should go here. Feel free to create as many subfolders as you want. 

• Public: This folder is for items you want to share with other 
people. Others can access these files using the Mac OS X Finder, 
Windows, or a Web browser. In addition, you can protect this folder 
with a password; see Protect Your Public Folder with a Password. 

• Shared: This folder appears only if you have a Family Pack 
account. Files in this folder can be shared among all the accounts 
within the Family Pack. When you put something inside the Shared 
folder on your iDisk, it automatically appears in the Shared folder 
of all your other Family Member account holders. Files in this folder 
count only toward the storage quota of the master account. 

• Sites: Web pages you’ve created in an application other than iWeb 
go here in order to publish them on the Web. I say more about the 
Sites folder in Create a Site Using Your Own Tools. 

• Web: This folder, if present, contains files uploaded by iWeb. 

I should also mention that the Library and Software folders are read-
only; you couldn’t change them even if you tried, though Apple 
software may change their contents in the background. 



92 

To Sync or Not to Sync? 
Mac users (only) can keep a copy of their iDisk contents on their 
hard disk; this copy syncs automatically with the iDisk server. You 
configure syncing in the MobileMe pane of System Preferences, in 
the iDisk view. It’s off by default; to turn it on, click Start. 

If iDisk syncing is off, then your iDisk is always live; when you 
open it, you see exactly what’s on Apple’s servers. So if you edit a 
file from your iDisk with syncing off, changes are saved directly to 
the server, but it takes longer for the file to open or save than if it 
were stored locally. And if you aren’t connected to the Internet, 
that file, along with anything else on your iDisk, is unavailable. 

If iDisk syncing is on, Mac OS X creates a hidden disk image 
on your Mac that can grow as needed (up to the capacity of your 
iDisk) and fills that disk image with the files currently on your 
iDisk. So what you see when you look “in” your iDisk in the Finder 
is the contents of this disk image—not necessarily what’s on the 
server. Mac OS X then syncs this disk image with your actual iDisk 
storage on the MobileMe servers. Syncing is useful for accessing 
files on your iDisk if your Mac is often without Internet access. 

If you enable iDisk Sync and choose Automatically from the 
Update pop-up menu (Apple’s suggestion), Mac OS X copies files 
to or from the server whenever changes are detected. Updates 
usually happen quickly, though there can sometimes be a delay 
of several minutes or more, even when your Internet connection 
is fine. (When you select the iDisk icon in the sidebar, the time of 
the last sync appears at the bottom of the window.) However, you 
can sync iDisk files manually at any time, as described next. 

If you choose Manually, your iDisk syncs only when you click the 
Sync icon  next to the iDisk icon in the Finder sidebar, or select 
the iDisk icon and choose Sync Now from the Actions menu  
in the Finder window’s toolbar. 

In Snow Leopard, there’s also a checkbox called Always Keep the 
Most Recent Version of a File. With this checked, if there's a sync-
ing conflict between the version of a file stored in the local copy 
of your iDisk and the version on Apple's servers, Mac OS X over-
writes the older version with the newer one, without displaying an 
alert each time asking you to make that decision. 
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We can rebuild it: If you change your MobileMe password while 
iDisk syncing is turned on, your iDisk has to rebuild itself. During this 
process, you’ll see a copy of the old image on your Desktop. Once the 
new image has synchronized and you’ve verified that the files are all 
there, you can delete this old image. 

SHARE FILES 
Although many people use their iDisk for remote access to their own 
files, you can also use your iDisk to share files with friends, family, or 
the general public. Apart from files shown on Web pages (including 
pictures and movies), the ideal way to accomplish this is to use your 
iDisk’s Public folder. Simply copy a file to this folder (as described 
ahead) to share it with others. Once you’ve done so, you have a number 
of options for how people access those files. 

Note: If you keep a local copy of your iDisk (see the sidebar To 
Sync or Not to Sync? just previously), files you copy to your iDisk 
may not be available to other users until after the next sync. To 
force an immediate sync, select the iDisk icon in the sidebar and 
either click the Sync icon  next to it, or choose Sync Now from 
the Actions menu  in the Finder window’s toolbar. 

Protect Your Public Folder with a Password 
By default, any file you place in your Public folder is freely available 
to anyone who knows your MobileMe member name (see Access an 
iDisk, just ahead). However, you can restrict access to this folder to 
people who know a password—separate from your own MobileMe 
password—you specify. To protect your Public folder with a password: 

1. Go to the MobileMe pane of System Preferences (Mac OS X) or the 
MobileMe control panel (Windows). 

2. Click the iDisk button. 

3. Check the Password-Protect Your Public Folder box. A dialog 
appears where you can enter (and confirm) a password. (If the 
dialog doesn’t appear automatically, click Set Password.) Optionally 
(under Mac OS X), click the key  button to open Password 
Assistant, which helps you select a secure yet memorable password. 
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4. To change the password, click the Set Password button and enter 
the new password. (Disabling and then re-enabling the password 
protection option will also prompt you for a new password.) 

You can remove password protection from your Public folder by 
returning here and unchecking Password-Protect Your Public Folder. 

Enable or Disable Write Access 
Although other users can see and download files in your Public folder, 
they can’t add or remove files by default. In other words, your Public 
folder is normally read-only to everyone but you. You can optionally 
give it read-write access, meaning that someone else can give you a file 
by putting it in your Public folder (and can delete files already there). 

To toggle between read-only and read-write access, do the following: 

• Snow Leopard: Open the MobileMe pane of System Preferences, 
click iDisk, and then check or uncheck Allow Others to Write Files 
in Your Public Folder. 

• Leopard: Open the MobileMe pane of System Preferences, click 
iDisk, and then select the Read & Write or Read Only radio button, 
as you prefer. 

• Windows: open the MobileMe control panel and select the Read & 
Write or Read Only radio button. 

This change takes effect immediately. 

If you enable write access, remember that files other people copy to 
your iDisk count against your quota. I therefore suggest checking your 
Public folder periodically and removing files you no longer need. 

ACCESS AN iDISK 
You can connect to your iDisk—or someone else’s—in any of several 
ways. Which you choose depends on your needs, preferences, and the 
type of device you’re using. Here’s where to find the right info: 

• Via the Web (from nearly any computer): To access your own 
iDisk, see “Use iDisk on the MobileMe Web Site,” just ahead. To 
access someone else’s Public folder, see Connect to Another User’s 
Public Folder. 
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• Mac OS X: Read Connect Using Mac OS X. 

• Windows: Find directions for Windows 7 and Vista in Connect 
Using Windows. 

• iPad, iPhone, or iPod touch: Skip ahead to Connect Using an 
iOS Device. 

Use iDisk on the MobileMe Web Site 
In the days of .Mac, it was possible to get to your iDisk from a Web 
browser, but the interface wasn’t very easy to work with. By contrast, 
today’s MobileMe iDisk application behaves very much like the Mac 
OS X Finder—specifically, a window in column view. It’s not perfect, 
but you can now do almost everything on the Web that you can do in 
the Finder. 

To access your iDisk, sign in to the MobileMe Web site and go to the 
iDisk application. You should see something resembling Figure 29 
(although the exact list of files and folders may vary). 

 
Figure 29: An iDisk on the MobileMe site works like the Mac Finder. 

In this view, you can do the following things: 

• Get more information about a file: Select a file to display its 
icon, kind, size, and modification date and time. 

• Resize columns: Drag the vertical line separating any two 
columns leftward or rightward. (You can’t resize the sidebar, 
however.) 
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• Upload a file: First, navigate to the location where you want the 
uploaded file to go; keep in mind that not all folders can be written 
to. Then, click the upload  icon in the toolbar, click Choose, and 
locate and select the file(s) you want to upload. (To select multiple 
contiguous files, Shift-click them; to select multiple noncontiguous 
files, Command-click them.) Click Select. After the files have 
uploaded, click Done. 

In the fold: Although you can upload multiple files at once, you 
can’t upload an entire folder. To get the same end result, first 
create the folder on the MobileMe site. Then upload all the files 
inside the folder on your computer to the newly created folder. 

• Download a file or folder: Select one or more files or folders 
and click the download  icon in the toolbar. (To select multiple 
contiguous files, Shift-click them; to select multiple noncontiguous 
files, Command-click them.) To download a single file, you can 
instead simply double-click it, or click the Download button in the 
preview pane that appears when the file is selected. 

• Share a file: If you want to send someone else a large file, rather 
than enclosing it in an email message (and risking running into a 
potential size limit imposed by MobileMe or the recipient’s ISP), 
you can upload the file to your iDisk and then share it from the 
MobileMe Web site. Each time you share a file, MobileMe generates 
a unique URL for the file that you can send to other people; you can 
optionally assign a password to each shared file, so you need not 
worry about someone accidentally stumbling across a shared file. 

To share a file, select it and click Share File. In the dialog that 
appears (Figure 30), click Share to share the file, which then 
becomes available at the URL shown at the top. (To see this URL 
later, select the file in the iDisk file browser on the MobileMe Web 
site; the URL will be displayed in the preview area that appears.) 
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Figure 30: In this dialog, specify the sharing options you prefer. 

While you’re here, you can optionally do any or all of the following: 

! Mail a link: To send a link to the file to others via email, enter 
one or more email addresses (separated by commas) and a brief 
message in the fields provided. The message is sent automatic-
ally, from your MobileMe address, when you click Share. 

Graphics required: The email message is sent in HTML for-
mat, with the Download link itself in the form of a graphic. If 
the recipient’s email client disables graphics display, the user 
must first display the graphics, and then click Download. 

Ordinarily, messages you send this way don’t appear in 
MobileMe Mail’s Sent mailbox. If you want to keep a copy of 
the sent messages, choose Actions  > Preferences, check Keep 
a Copy of Sent Emails When Sharing Files, and click Save. 
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! Set an expiration period: By default, a link expires after 
30 days—the file remains on your iDisk but is no longer shared. 
To disable expiration (making the link work indefinitely), un-
check Link Expires After. To set a different expiration period, 
enter a number in the field and choose Days, Weeks, or Months 
from the pop-up menu. 

! Password-protect the file: To require a password when 
someone else accesses this file (separate from the password you 
may have set up for your iDisk’s Public folder), check Password-
Protect File and enter the desired password in the field. 

Change happens: To change any of these settings later, select 
the file on the MobileMe site and click Sharing Options to display 
a similar dialog. In this dialog, you can also cancel sharing by 
clicking Stop Sharing. 

• Rename a file or folder: Select a file or folder and press Return 
(or Enter). Type in a new name or edit the existing name, and press 
Return (or Enter) again. 

• Move a file or folder: Drag a file or folder into another folder 
within your browser window to move it. 

• Delete a file or folder: Select one or more files or folders and 
click the Trash  icon in the toolbar. Click OK to confirm. 

• Duplicate a file or folder: Select one or more files or folders and 
choose Actions  > Duplicate. 

• Create a new folder: Choose Actions  > New Folder, type in 
a name, and press Return (or Enter). 

• Compress a file or folder: Select one or more files or folders 
and choose Actions  > Compress “item-name” to create a com–
pressed copy in ZIP format. (The original, uncompressed copy 
remains in place, though you can delete it manually.) 

• Decompress a file: Select a ZIP archive and choose Actions  > 
Decompress “item-name.” 

In the fold: When MobileMe decompresses a ZIP file, it always 
creates a new folder—even if the archive contains only one file. 
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• Simplify the folder layout: To hide some of the special folders 
used by Mac OS X or MobileMe (most of which you can’t use or 
modify anyway), choose Actions  > Preferences, check Show 
Simple Folder Layout, and click Save. 

• Add a folder to the sidebar: If you want to access a certain fol-
der on your iDisk quickly, select the folder and choose Add “folder-
name” to Sidebar from the Actions  pop-up menu at the bottom 
of the sidebar. To remove a folder from the sidebar, select the folder 
and choose Remove “folder-name” from Sidebar from the same 
menu. (You can’t reorder these shortcuts in the sidebar without 
deleting them and re-adding them in the order you prefer.) 

• Check your storage quota: To see how much of your allotted 
space is in use, click the Info  button at the bottom of the sidebar. 
Click the button again to hide storage space information. 

• Change permissions for your Public folder: You can modify 
your Public folder’s password and its read/write settings using the 
MobileMe pane of System Preferences in Mac OS X or with the 
MobileMe control panel in Windows (see Protect Your Public Folder 
with a Password and Enable or Disable Write Access), but you can 
do the same by choosing Actions  > Preferences and using the 
controls in the Public Folder portion of the dialog. 

• Access another user’s Public folder: Choose Actions  > 
Open a Public Folder, enter the user’s member name, and click 
Open; enter the password for that user’s Public folder if prompted. 
The user’s public folder opens in a new browser tab or window. 

Folder Overflow 
If you were a .Mac member, you may see a HomePage folder in 
the sidebar containing any Web sites you published using .Mac’s 
HomePage feature. (Although the pages are still visible, they’re no 
longer editable via the Web, and links to media files may break as 
of November 2011. For details, read “He's Leaving Home(Page)—
Bye, Bye!,” http://db.tidbits.com/article/11656.) You may also see 
an iWeb folder in the sidebar (for sites created in iWeb), plus a 
Shared Files icon, which lists all files currently being shared. (Note 
that even if a shared file’s link expires, the file appears here 
unless you stop sharing the file or delete it from your iDisk.) 
 

http://db.tidbits.com/article/11656
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Connect Using Mac OS X 
If you’re using Mac OS X, you ordinarily needn’t do anything at all 
to connect to your own iDisk—as long as you have an Internet connec-
tion, Mac OS X automatically connects to your iDisk when you access 
it. You can display the contents of your iDisk by clicking the iDisk icon 
in Finder-window sidebars, by choosing Go > iDisk > My iDisk, or by 
pressing Command-Shift-I in the Finder. 

Note: When your own iDisk icon appears in the sidebar, it has the 
label “iDisk.” When an iDisk icon appears on the Desktop, or when 
another user’s iDisk or Public folder appears in the sidebar, its 
label is the MobileMe member name of the iDisk’s owner. 

Connect to Another User’s iDisk 
At times, you may want to retrieve personal files from your iDisk while 
using someone else’s computer, or someone using your computer may 
want to connect to their own iDisk. To access, as its owner, an iDisk 
other than the one specified in MobileMe System Preferences: 

1. Choose Go > iDisk > Other User’s iDisk. 

2. Enter the user’s member name and password, and click Connect. 

The other user’s iDisk appears in the sidebar of Finder windows, and 
a window displays its contents. 

Connect to Another User’s Public Folder 
To access only the Public folder of another user’s iDisk: 

1. Choose Go > iDisk > Other User’s Public Folder. 

2. Enter the member name for the other user and click Connect. If the 
user’s Public folder is password-protected, you’ll be asked to 
provide that password. 

The other user’s iDisk appears in the sidebar, and a window displays 
the contents of its Public folder. 

Once an iDisk is visible in the Finder, you can copy, add, or remove 
files (subject to the limitations of individual folders) using drag-and-
drop or copy-and-paste, just as you would for any other volume. 
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Connect Using Windows 
If you’re running Windows 7 or Windows Vista, you can follow these 
steps to map your iDisk to a network drive: 

1. Choose Start > Computer. 

2. Near the top of the window, click the Map Network Drive link. 

3. In the window that appears, first choose a drive letter to which your 
iDisk will be mapped (in most cases, just accept the default, which is 
likely very late in the alphabet). 

4. In the Folder field, enter http://idisk.me.com/member-name 
(replace member-name with the MobileMe member name of the 
person whose iDisk you’re trying to use). 

5. Optionally, check Reconnect at Logon, if you want to connect to 
your iDisk automatically whenever you use Windows. 

Public folders: These instructions assume you’re accessing your 
own iDisk, or someone else’s whose password you know. To access 
a user’s Public folder, add -Public to the end of the URL in Step 4. If 
the folder isn’t password-protected, skip Step 6. 

6. Click the blue link that says “different user name.” In the dialog 
box that appears, enter the appropriate MobileMe member name 
and password, and click OK. 

7. Click Finish. 

A window appears, showing the contents of the selected iDisk. Also, 
the iDisk icon is added to your list of network locations, so you can use 
your iDisk at any time by double-clicking that icon. 

Connect Using an iOS Device 
If you have an iPhone, iPad, or iPod touch, you can use Apple’s iDisk 
app to view the files on your iDisk, as well as to share those files with 
others by emailing links to the files, much like you can do from the 
MobileMe Web site. This app also lets you view, on your mobile device, 
files stored in another user’s Public folder. 

To do this capability, you need an iPhone, iPad, or iPod touch (any 
model) with iPhone OS 3.0 or higher, plus Apple’s free MobileMe iDisk 
app. 

http://itunes.apple.com/us/app/mobileme-idisk/id320654497
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The first time you use the app, it asks for your MobileMe member 
name and password. It then shows a list of all the folders on your 
iDisk, letting you navigate through the hierarchy as in any other 
iPhone app. Figure 31 shows a subfolder within my iDisk’s 
Documents folder, as viewed on an iPhone. 

 
Figure 31: The iDisk app lets you view and share files on your iDisk. 

Tap the name of any file to download and display it. The app supports 
all the usual file types, such as PDF, text, rich text, Microsoft Office, 
and iWork ’09, as well as most popular audio, video, and graphics 
formats. 

The app keeps a cached copy of most downloaded files so that you can 
view them again without having to re-download. The size of the cache 
can vary from 50 to 200 MB. To adjust it, navigate to the top level of 
your iDisk in the app and tap Settings. Tap Local Storage, and move 
the slider left or right to choose the size you want. The Settings view 
also lets you choose whether to show file extensions or System folders 
(such as Backup, Data, Sites, and Web). 

Except when you need it most: Unfortunately, caching doesn’t 
apply to audio and video files. Those are always streamed from your 
iDisk rather than being copied to your mobile device. 
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To share a file, do the following: 

1. Tap the sharing icon: 

• In list view, the sharing  icon is to the right of the file name. 

• If you’re viewing the file, the sharing  icon is at the bottom. 

2. Optionally do either or both of the following: 

• To change the expiration date (1 month ahead by default), tap 
Expires, and then tap the time period after which you want 
sharing to stop (or tap Never to share the file permanently—or 
until you manually disable it). Then tap Done. 

• To add password protection, tap Password, enter a password, 
and tap Done. 

3. Share the file: 

• To share the file immediately, without sending a link, tap Share.  

• To share the file and email a link to the shared file, tap Share & 
Email Link. The app activates sharing and opens a new email 
message containing a link to that file. Enter one or more email 
addresses, optionally change the subject and enter a message 
(just as in the mobile Mail app), and tap Send.  

The item’s sharing icon turns green, and the word “Shared” appears 
next to its size. 

To stop sharing a file, tap its shared  icon, then tap Stop Sharing. 

The iDisk app has a few other useful features: 

• To get more information about a file: While viewing a file, tap 
the Info  button to display information about it, such as its size 
and modification date. Tap the eye  button to return to viewing 
the file. 

• To delete a file: In list view, tap Edit, tap the delete  icon to 
the left of the file name, and tap Delete. To delete the file you’re 
currently viewing, tap it and then the Trash  icon at the bottom. 

• To view another user’s Public folder: Tap Public Folders. 
Public folders you’ve previously viewed appear in the list; tap one 
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to view it. To add to the list, tap the plus  button, enter a member 
name, and tap Save. You’re prompted to enter the Public folder’s 
password, if one is required. 

• To view all shared files: Tap Shared Files at the bottom. The app 
displays a list of all files currently being shared. Tap the icon to the 
right of a file to change its sharing status. 

• To see recently viewed files: Tap Recents at the bottom to see 
your recently accessed files, most of which should still be cached. To 
clear the list, tap Clear, and then tap Clear All Recents. 

That’s pretty much it. Unfortunately, Apple’s iDisk app doesn’t let 
you move files to other locations on your iDisk, rename them, or edit 
them—not even simple text files. If you need any of these features, or 
the option to access other WebDAV servers, you can try any of numer-
ous third-party apps that offer iDisk access, such as these: 

• Air Sharing Pro (iPhone/iPod touch) and Air Sharing HD (iPad): 
These apps let you use your iOS device as a file server over Wi-Fi, 
copy files between your Mac and your mobile device, zip/unzip files, 
email links to files and folders up to 100 MB (after they’ve been 
uploaded to the company’s servers), connect to iDisk, WebDAV, 
Dropbox, FTP, SFTP, and other servers, and more (Air Sharing Pro, 
$6.99; Air Sharing HD, $9.99). 

• GoodReader for iPhone and GoodReader for iPad: If you want to 
read PDF documents—especially complex ones, like Take Control 
books—on your iPad, GoodReader is an outstanding tool for the job. 
Its display is first-rate, and it supports internal and external links, 
searching, adjustable brightness, and more. But GoodReader isn’t 
only for PDFs; it can also store and display all standard iPad docu-
ment types; fetch documents from many kinds of local and cloud 
servers; and even save archives of Web pages for offline reading. 
(Good.iWare, $0.99 “introductory price”) 

• Office2 (iPhone/iPod touch) and Office2 HD (iPad): These apps you 
create and edit word processing documents and spreadsheets—and 
view all standard document types. Both apps support Google Docs, 
iDisk, WebDAV, and other cloud-based services. (Byte2, Office2, 
$5.99; Office2 HD, $7.99) 

http://phobos.apple.com/WebObjects/MZStore.woa/wa/viewSoftware?id=312686749&mt=8
http://itunes.apple.com/us/app/air-sharing-hd/id365541415?mt=8
http://itunes.apple.com/us/app/goodreader-for-iphone/id306277111?mt=8
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fgoodreader%2Dfor%2Dipad%2Fid363448914&ul=tc
http://itunes.apple.com/us/app/id350399839?mt=8
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fid364361728&ul=tc
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• PrintCentral for iPhone/iPod Touch and PrintCentral for iPad: 
Although intended primarily as a tool for printing (see Print from 
Your iPad), PrintCentral is also a full-featured file transfer and 
storage app, with support for WebDAV and FTP servers, iDisk, and 
Macs and PCs with the company’s free desktop software installed. 
(EuroSmartz, PrintCentral for iPhone/iPod touch, $7.99; 
PrintCentral for iPad, $9.99) 

• ReaddleDocs and ReaddleDocs for iPad: This app offers access to 
iDisk, WebDAV, Dropbox, Google Docs, and other servers; saves 
files from the Web or email attachments; and shares files via Wi-Fi 
with other ReaddleDocs users (Readdle, $4.99 for either version) 

Ups and downs: Most of the apps that let you email iDisk-hosted 
files to others require that the file first be downloaded to your device 
and then sent as an attachment (so you must wait for it to transfer 
twice!). In other cases, you can email a link, but only to a file in your 
Public folder, or to a file that’s been uploaded to a third-party server. 
By contrast, Apple’s iDisk app lets you email a link to any file already 
on your iDisk (whether in your Public folder or not)—without having 
to download it to your device at all. 
Another way to email a link to a file not already on your device is 
SugarSync, which I described in “SugarSync Sweetens Online 
Syncing” (http://db.tidbits.com/article/9751). 

Understand Data Transfer Limits 
Many Web hosting companies limit the amount of data that can be 
transferred from a member’s site per month. This prevents a few busy 
sites from reducing performance for everyone who uses it—and it 
limits the cost of the company’s Internet connection. Your MobileMe 
account, too, has data transfer limits. Basic MobileMe accounts have 
a limit of 200 GB of data transfer per month; by buying more storage 
(40GB for $49 per year or 60GB for $99 per year), you can increase 
that limit to either 400 GB or 600 GB per month, respectively (see Buy 
More Space, ahead). 

Even the standard data-transfer limit of 200 GB should be more than 
adequate for most people. If you get close to your limit, Apple will send 
you an email message inviting you to buy more storage. If you choose 
not to—or if you already have the maximum amount—Apple disables 

http://itunes.apple.com/us/app/printcentral-for-iphone-ipod/id367455861?mt=8
http://click.linksynergy.com/deeplink?id=ExkrLhhvFQQ&mid=13508&murl=http%3A%2F%2Fitunes%2Eapple%2Ecom%2Fus%2Fapp%2Fprintcentral%2Dfor%2Dipad%2Fid366020849&ul=tc
http://itunes.apple.com/us/app/readdledocs-documents-attachments/id285053111?mt=8
http://itunes.apple.com/us/app/readdledocs-for-ipad-pdf-viewer/id364901807?mt=8
http://db.tidbits.com/article/9751


106 

access to your Web site(s) and any other data on your iDisk until the 
beginning of the next bimonthly1 monitoring period. 

Note: Apple calculates your data transfer usage in an unusual 
way. Although a standard membership includes 200 GB of data 
transfer per month, what that really means is 100 GB every half 
month. So if you use up 100 GB in the first week of a month, 
Apple disables iDisk access until the 16th. Then you get another 
100 GB for the second half of the month. 

Determining how much of the monthly data transfer quota you’re 
using can be tricky. For example, if you put a 10 MB file on your iDisk, 
you can’t tell if it has been downloaded once or a thousand times. The 
MobileMe Web site has a way for you to see your recent usage. To 
check your current data transfer statistics, follow these steps: 

1. While signed in to MobileMe, choose Account from the pop-up 
menu in the upper-right corner—the one that displays your name—
and enter your password when prompted. 

2. On the Summary pane, under “Account Details,” is a line that says 
“Data Transfer.” Click the Details link at the end of that line. 

A dialog appears, giving you the information you need to determine 
your current monthly usage: 

• The paragraph at the top of the page tells you how much data 
transfer remains available during the current half of the month. 
Remember that the bimonthly limit is half of your monthly limit. 

• The Usage History table lists amounts used in previous months. 
During the month preceding a given date, you transferred the 
amount of data shown in the second column. So the figure for the 
month “05/10” is the amount of data transferred in April 2010. 

Note: In calculating data transfer usage, Apple counts only out-
bound traffic from your iDisk (such as Web access, downloading 
files from the iDisk, and other remote access). Uploading files to 
your own site doesn’t count, but all downloading does. 

                                            
1 Apple uses the term “bimonthly” to mean twice a month, not every 2 months. 
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Divide Space between Files and Email 
Your MobileMe account comes with 20 GB of storage space, but not 
all of that space is available for use by your iDisk. Apple allocates some 
of the space to storing your MobileMe email; your iDisk gets the rest. 
By default, the 20 GB is divided evenly: 10 GB each for email and iDisk. 
But you can adjust this setting to meet your needs. 

Note: The 20 GB figure applies only to individual accounts. If 
you’re using a free MobileMe trial membership, you get 100 MB 
of storage. If you have a MobileMe Family Pack, the primary 
member gets 20 GB while each Family Member gets 5 GB. 

To change the allocation of your storage space, follow these steps: 

1. While signed in to MobileMe, choose Account from the pop-up 
menu in the upper-right corner—the one that displays your name—
and enter your password when prompted. 

2. Click the Storage Settings button in the sidebar to display the 
Storage Settings pane (Figure 32). 

 
Figure 32: Divide storage between email and iDisk here. 

3. Choose a new setting (1 GB minimum) from the Mail pop-up menu; 
MobileMe automatically assigns the rest of your available space to 
your iDisk. When you’re finished, click Save. 

The change generally takes effect within a few minutes. 
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Buy More Space 
The amount of storage space included with your MobileMe account—
and the amount you can add for an extra fee—has changed several 
times over the years. As of September 2010, Apple offers three options: 

• The standard 20 GB, including 200 GB of data transfer per month 

• An optional upgrade to 40 GB total storage and 400 GB of data 
transfer per month for $49 extra per year 

• An optional upgrade to 60 GB total storage and 600 GB of data 
transfer per month for $99 extra per year 

These figures will no doubt change again in the future. 

To increase your total storage space from 20 GB to 40 GB or to 60 GB, 
you can do either of the following: 

• In the Account view of MobileMe, click the Upgrade button in the 
Summary pane or the Upgrade button in the Account Options pane 
(which will read “Add Upgrades” if you have a Family Pack). 

• In MobileMe System Preferences (Mac OS X) or the MobileMe 
control panel (Windows), click Upgrade Storage in the iDisk view. 

You can then choose the level of storage you want to buy and enter 
your credit card info to complete the purchase. 

A few “fine-print” details about increasing your storage space are 
worth highlighting: 

• If you upgrade your storage capacity partway through your 
subscription (i.e., not on the same day you purchase or renew a 
subscription), Apple charges you a prorated fee. For example, if 
your subscription is due for renewal in 6 months, Apple charges 
you only $24.50 for the upgrade to 40 GB. 

• By default, if you’ve set your account to auto-renew, your upgraded 
storage space renews automatically (at the full rate) at the same 
time your MobileMe subscription does. 

• When you upgrade, Apple divides your MobileMe storage space 
evenly between email and iDisk—regardless of how you divided 
it earlier. You can then change it again manually (refer to Divide 
Space between Files and Email, previously). 
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Find My iPhone 
 
If you’re an iPhone, iPad, or iPod touch owner, you can use the 
MobileMe Web site to locate your device if it’s lost or stolen. You 
can also display a message on its screen, play a sound, remotely 
change its passcode, or even remotely wipe all the device’s data 
(to keep it private in case you’re unable to retrieve the device). This 
feature is called Find My iPhone. (It’s actually called Find my iPod 
touch for iPod touch owners, and Find my iPad for iPad owners, but 
for simplicity’s sake, I refer to it here only as Find My iPhone.) 

This feature works more reliably on iPhones and 3G iPad models 
than on devices without cellular capabilities. Devices with 3G 
support are more likely to have an always-on network connection—
cellular access is pretty ubiquitous, whereas Wi-Fi is spotty. Plus, 
iOS devices with 3G support also have GPS chips, so their reported 
location is generally much more precise than for devices that lack 
GPS. Note, however, that the iPhone and iPad maintain their mobile 
connections even when “sleeping,” whereas the iPod touch won’t 
display any messages or report its location until it’s woken up. 

ACTIVATE FIND MY iPHONE 
Before you can use Find My iPhone, two prerequisites must be met: 

• Your mobile device must be running iPhone OS 3.0 or higher 
(including any iOS version). If it isn’t, connect the device to your 
computer, open iTunes, select the device in the sidebar, and click 
Check for Update on the Summary pane. Install the latest software. 

• You must activate Find My iPhone on your iOS device itself. To 
do this, tap Settings; then Mail, Contacts, Calendars; then your 
MobileMe account. Make sure Find My iPhone is set to On 
(Figure 33); if not, tap the Off switch to turn it on. 

Note: Although you can set up more than one MobileMe account 
on an iPhone or iPod touch, Find My iPhone can be enabled for 
only one of the accounts. 
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Figure 33: Find My iPhone must be enabled on your iOS device 
before you can use it. 

With your device(s) properly configured, you can then find the device 
either using the MobileMe Web site (as described next) or using an app 
installed on another iOS device—yours or someone else’s—as I discuss 
ahead in Find our iPhone with an App. 

FIND YOUR iPHONE IN A BROWSER 
The first method to find your iPhone is to use any supported Web 
browser. To do so, sign in to the MobileMe Web site and go to the Find 
My iPhone application.  

If you have only one iOS device, the entire window shows a map on 
which MobileMe tries to locate that device. If you have more than one 
iOS device, a Devices list appears in a sidebar on the left (Figure 34); 
select a device to view location data. (If you have multiple Find My 
iPhone-enabled devices, when you open the Find My iPhone app, 
MobileMe attempts to locate all those devices. In the Devices list, a dot 
appears beside each device name to indicate its status: gray  means 
trying to connect; red  means offline, and green  means online.) 

Assuming the selected device is turned on and online, the map shows 
its current location. Just as in the Maps app on the device, the location 
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becomes increasingly specific as Find My iPhone zeroes in on its loca-
tion using a combination of cell tower triangulation, Wi-Fi network 
identification, and GPS, depending on which of these are available.  

If the device has just been found, a blue arrow  appears next to its 
name on the map; if the device was previously found but can’t be 
located now, a red clock icon  appears next to it instead, indicating 
that this is the device’s last known location. 

 
Figure 34: The Find My iPhone application on the MobileMe Web site 
displays a map showing your iOS device’s current location. 

If your device is in motion, you may want to update the display from 
time to time. To ask the iOS device to recalculate its location, click the 
Update  button on the toolbar. 

Beyond merely locating the device, you can take any or all of several 
other steps. To do so, first click the blue arrow  or red clock  icon. 
(If the device can’t be located—for example, it’s off or, in the case of an 
iPod touch, asleep—these icons don’t appear, and instead you see the 
following actions immediately.) Then choose any of the following: 

• Display Message or Play Sound: To show a message on your 
device’s screen, even if it’s locked, click the Display Message or Play 
Sound button. In the pop-up window that appears, type a message 
(up to 160 characters). Instead—or in addition—check the Play a 
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Sound for 2 Minutes box to make your device play a pinging sound. 
(This works even if the device is in silent mode, and can help you 
locate it if you misplaced it in your home or office.) Then click Send.  

On the mobile device, you can turn off the sound and/or dismiss the 
message by unlocking the device and then tapping the OK button. 

• Lock: Depending on your device’s iOS version, you can lock it with 
its existing passcode, or set and/or change its passcode. Locking 
your device prevents anyone else from using it and seeing its data. 
The following options are available: 

! iOS 3.1.x or 3.2.x: You can set a four-digit passcode—or replace 
an existing passcode—and then lock the device. 

! iOS 4 or later: You can set a passcode if the device doesn’t 
already have one, but you can’t replace an existing passcode. If 
the device does have a passcode, you can lock it immediately. 

To do any of these activities, begin by clicking Lock. To set or 
change a passcode, enter the new passcode, click Next, and reenter 
the passcode. To activate the (new or existing) passcode, click Lock. 

Extra security: If your iOS device is unrecoverable, you may 
want to erase its data with the Wipe feature (next). However, even 
if you plan to wipe the device, locking it first can be useful for older 
devices such as the iPhone 3G and second-generation iPod touch. 
These older devices take a while to erase their data, and while 
that’s happening, a determined attacker could potentially retrieve 
sensitive data. (Newer devices, such as the iPhone 3GS, iPhone 4, 
and iPad, can rapidly and securely delete all their data.) 

• Wipe: If your iOS device has been stolen or is otherwise 
unrecoverable for any reason, you can tell MobileMe to securely 
erase all its data—your email messages, address book, photos, apps, 
and everything else—so that at least whoever has the phone can’t 
access your personal information. To do this, click Wipe, read the 
warning and check the I Understand That I Cannot Undo or Stop 
This Action box, and click Erase All Data. Once you’ve done this, the 
Find My iPhone features are no longer available (because the device 
no longer contains your MobileMe data—it’s essentially blank). 
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Use quickly but carefully: Erasing a missing device’s data can 
provide peace of mind, but it’s easy to defeat. All a thief would have 
to do is turn off Find My iPhone on the device or activate Airplane 
Mode (though if you’ve set a passcode, a thief would be slowed 
down or blocked). Therefore, if you’re going to use this feature, you 
should do so quickly—before someone has a chance to block you. 
But remember: wiping your data prevents you from using Find 
My iPhone, so don’t take this step if you think it’s likely that the 
device is sitting on a bus seat or is otherwise recoverable. 

Always Use a Passcode 
Because a passcode protects your data from prying eyes and buys 
you time to use Find My iPhone, it’s a must for anyone concerned 
about security. I recommend not waiting until your device has 
gone missing; setting a passcode via Find My iPhone should be a 
last resort. To set a passcode, tap Settings > General >Passcode 
Lock. The shorter the time you set before the device automatically 
locks, the less chance someone will have to disable that passcode. 

FIND YOUR iPHONE WITH AN APP 
If you have access to another iOS device, you have another way to find 
your wayward device and perform any or all of the activities described 
just previously (displaying a message, playing a sound, locking the 
device, or wiping it). All you need is Apple’s free Find My iPhone app, 
which, despite its name, supports the iPhone, iPad, and iPod touch. 

To use the app, follow these steps: 

1. Tap the Find iPhone icon to launch the app. 

2. Enter the MobileMe member name and password associated with 
the device you want to find, and then tap Go. 

Once you’re signed in, the app offers the same features as Find My 
iPhone on the MobileMe Web site (discussed, just previously), 
although the interface varies with the device on which you’re using it. 
When you’re done, tap Sign Out. The app forgets your MobileMe pass-
word when you sign out, so you can safely use the app on someone 
else’s device. 

http://itunes.apple.com/us/app/find-my-iphone/id376101648
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Account 
 
In the Account view of the MobileMe Web site, you can add storage, 
change your password or billing information, and make other 
changes that affect your account as a whole. 

To manage your account, sign in, choose Account from the pop-up 
menu in the upper-right corner—the one that displays your name—
and provide your password again. Then click a link in the sidebar 
to visit the pane with the information you want to change. In this 
chapter, I look at each of the panes in turn. 

SUMMARY 
The Summary pane (Figure 35) provides an overview of your account. 
The right side of the pane also includes announcements and status 
reports about the MobileMe service. 

 
Figure 35: Manage your account settings in this pane. 
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To change how your storage space is divided between iDisk and email, 
click the Settings button (which takes you to the Storage Settings pane, 
described ahead).  

Clicking the Options button is another way to get to the Account 
Options pane, described below, where you can renew or upgrade your 
membership. Clicking the Upgrade button in the Summary pane (or 
the Account Options pane) lets you upgrade to a Family Pack or add 
storage. (If you already have a Family Pack, the button in the Account 
Options pane will read “Add Upgrades.”) 

PERSONAL INFO 
Click the Personal Info link to display a pane where you can change 
your first or last name, alternate email address, preferred language for 
the MobileMe interface (choices are English, Japanese, French, and 
German), and your local time zone. You can also check or uncheck 
a box indicating your willingness to receive email updates from Apple. 

After making any changes in this pane, click Save. 

ACCOUNT OPTIONS 
To renew your MobileMe subscription automatically each year (at 
Apple’s full retail price, naturally), check the Renew box in the Account 
section. (For Family Packs, you must check two boxes—one box for the 
main account and one box for the Family Pack.) To cancel automatic 
renewal, uncheck the box(es). (Automatic renewal uses the credit card 
you specify in the Billing Information pane.)  

Tip: You can also renew your subscription by buying a discounted 
MobileMe retail box and entering the activation code it contains. 

If you have a standard MobileMe membership and want to upgrade to 
a Family Pack account (for an extra $50 per year), or to increase your 
total storage space to 40 GB (for an extra $49 per year) or 60 GB (for 
an extra $99 per year), click the Upgrade (or Add Upgrades) button, 
make your selections, click Continue, and follow the instructions. 

After making any changes in this pane, click Save. 
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BILLING INFORMATION 
Update the credit card information on file for your membership in 
this pane. Note that Apple provides no way to remove a credit card 
from their database, only to change it—if you erase an existing card 
number and click Save, you only get an error message telling you that 
the card number and security code must be filled in, and if you navi-
gate to another pane and return, you’ll see your old values still there. 

After making any changes in this pane, click Save. 

PASSWORD SETTINGS 
In this pane, you can change your password or enter a new password 
question and answer (which enables you to reset your password if you 
forget it). You can also enter or correct your date of birth, which Apple 
may use to help verify your identity. 

After making any changes in this pane, click Save. 

STORAGE SETTINGS 
Choose how much of your MobileMe storage space is allocated to your 
iDisk and how much is set aside for email (see Divide Space between 
Files and Email). 

After making any changes in this pane, click Save. 

PERSONAL DOMAIN 
MobileMe lets you use your own domain name with MobileMe Web 
sites published from iWeb. If you’d like a shorter or more personal 
URL for your site than one beginning with www.me.com, you can 
register a domain of your own and have it redirected to your MobileMe 
site. With this feature activated, MobileMe becomes a Web host for 
your own domain. In other words, type www.your-domain-name.com 
into a browser and up pops your MobileMe-hosted Web site—the one 
created in iWeb and stored on your iDisk. 
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Note that you can’t use MobileMe to host email from another domain 
name, and according to Apple, only sites created in iWeb ’08 or later—
not ones created in another application, and not even a MobileMe 
Gallery—work with your personal domain. However, some users have 
found that if they create sites with their own tools and store them in 
the Web folder (not the Sites folder, nor the Sites subfolder of the Web 
folder) on their iDisk, those sites are available within their personal 
domain. See Create a Site Using Your Own Tools for details. 

To set this up, follow these steps: 

1. Register a domain name (if you haven’t done so already) with 
any of the numerous registrars. If you need advice with this step, 
I recommend reading Take Control of Your Domain Names. 

2. Click the Personal Domain link in the Account pane of MobileMe. 

3. Click Add Domain. Enter (and confirm) your domain name and 
then click Continue. 

4. Following the instructions provided, visit your registrar’s Web site 
and set up an alias (technically called a CNAME) for “www” that 
points to web.me.com. 

5. Return to the Personal Domain pane as in Step 2, and click 
Continue to finish setting up your domain name. 

From now on, anyone going to your domain name in a Web browser 
will see your MobileMe-hosted site. 

SECURITY CERTIFICATES 
Click this link to view the status and expiration date of security 
certificates used for iChat encryption and Back to My Mac. (You can 
revoke these certificates here, as well.) To enable iChat encryption, 
open iChat, choose iChat > Preferences, and click Accounts in the 
toolbar. With your MobileMe account selected, go to the Security view, 
click the Encrypt button at the bottom, and follow the instructions. 

http://www.takecontrolbooks.com/domain-names?pt=INTERNAL
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MobileMe and iLife 
 
Another important aspect of MobileMe is the way it integrates 
with iLife, Apple’s suite of software for managing digital media on 
a Mac. iPhoto, iMovie, iWeb, and GarageBand, while all useful on 
their own, become extra powerful when used in conjunction with 
a MobileMe subscription. (iDVD, also part of iLife, does not have 
any MobileMe-specific features.) 

CREATE SITES AND BLOGS WITH iWEB 
iWeb makes it easy to design attractive Web sites, as well as create 
blogs; publish podcasts directly from GarageBand; and add content 
to your site from iPhoto, iMovie, or iTunes with just a click or two. 
You can use iWeb to create a Web site and upload it to any Web 
hosting provider, but in this book I cover an easier approach: 
publishing your site directly to MobileMe. 

(Besides creating a site or blog in iWeb, you can also start in iPhoto, 
iMovie, or GarageBand and send your content to iWeb. I describe 
those approaches as well; see Publish Photos from iPhoto, Publish 
Movies from iMovie, and Publish a Podcast with GarageBand, all later 
in this chapter.) 

Note: iWeb offers many options I can’t cover here. To learn how 
to go beyond the basics, see Steve Sande’s Take Control of iWeb 
’09. 

To create a basic Web site or blog using iWeb, follow these steps: 

1. Open iWeb. If you see a “Welcome to iWeb” window, click Close. 
The next thing you should see is a dialog (Figure 36) listing a 
variety of templates. (If iWeb is already open, click the plus  

button at the bottom of the window to display the templates.) 

http://www.takecontrolbooks.com/iweb?pt=INTERNAL
http://www.takecontrolbooks.com/iweb?pt=INTERNAL
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Figure 36: Every page you create in iWeb starts with a template. 
Pick an overall style from the list on the left, then a specific page 
type. 

2. Select a template theme from the list on the left (you can optionally 
narrow the list of options by choosing a category from the pop-up 
menu), and then select a page type on the right. For a blog, you 
must select either a Blog template or, if you expect to include audio 
or video podcasts in your blog, a Podcast template. Click Choose. 
iWeb opens the template you selected, with placeholder pictures 
and text. 

3. On the right side of the window, you should see a pane listing 
various kinds of media you can insert into an iWeb page, including 
Audio, Photos, Movies, and Widgets; this is called the Media 
Browser (Figure 37). If you don’t see it, choose View > Show 
Media Browser. 
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Figure 37: The Media Browser gives you instant access to your 
iTunes music, iPhoto photos, and iMovie movies from within iWeb. 

4. To replace the placeholder photos, locate a photo on the Photos 
pane of the Media Browser and drag it onto the photo you want to 
replace. To add a photo to any other part of the page, select it and 
drag it to the desired location. You can then resize or reposition it. 

5. To replace the placeholder text, double-click a paragraph and type 
in your own text. To add text in a new location on the page, click 
the Text Box button at the bottom of the window. You can resize 
or reposition any text box simply by dragging. 

If you’re using a blog template, you can create a new entry (with its 
own placeholders) by first selecting Entries in iWeb’s sidebar and 
then clicking the Add Entry button. 

6. Repeat Steps 4 and 5 until you’re satisfied with the page or blog 
post. 
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7. If you want to add more pages to your site, click the plus  button 
at the bottom of the window. Then repeat Steps 2–6. iWeb 
automatically places a link to every new page in your site in the 
navigational area at the top of each page. 

8. To make your blog support user comments, work in iWeb’s Site 
Inspector palette (if it’s not visible, choose View > Show Inspector). 
Go to the RSS pane, and in the Blog view, check the Allow 
Comments checkbox. If you want commenters to be able to upload 
files (such as graphics), also check Allow Attachments. 

9. When you’re finished, choose File > Publish Entire Site. 

iWeb uploads the page(s) and its photos to your iDisk, and then it 
displays a dialog with the site’s URL, as well as buttons for visiting the 
site in your default browser and sending an email message announcing 
the site. 

To add another blog entry, select the blog’s Entries page in iWeb’s 
sidebar. Click the Add Blog Entry button and repeat Steps 4–5. After 
making changes to the site, choose File > Publish Site Changes; iWeb 
uploads only new or changed pages. 

Note: By default, Web sites you create in iWeb have URLs that 
follow this pattern: http://web.me.com/member-name/site-name. 
If you already had a site in the web.mac.com domain, the existing 
URL will continue to work, and your old sites can now also be 
accessed at the corresponding web.me.com URL. 

PUBLISH PHOTOS FROM iPHOTO 
Although MobileMe Gallery (see Gallery, earlier) is spiffy and easy to 
use, you may prefer the control that iWeb provides, or you may want to 
include your photos in iWeb blog entries. In these cases, you can create 
an album on your iWeb site from within iPhoto. Follow these steps: 

1. Select one or more photos (or, if you prefer, an entire album). 

2. Choose Share > Send to iWeb > Photo Page. (If you want the 
photo(s) to appear as part of a blog entry, instead choose Share > 
Send to iWeb > Blog.) iWeb opens. 
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3. Select a template and click Choose. iWeb imports your photos 
and creates a page with thumbnails and a Start Slideshow button. 

4. If you wish, add captions, drag photos to rearrange them, or modify 
other information—such as the page’s title and introductory text. 

5. To create additional pages with more photos, repeat Steps 1–4. 

6. Choose File > Publish Entire Site. 

iWeb uploads the page and photos to your iDisk, and then shows a 
dialog with the site’s URL and buttons you can use to visit the site in 
your default browser or send an email message announcing the site. 

PUBLISH MOVIES FROM iMOVIE 
If you want to publish a movie from iMovie on an iWeb site, you must 
first share them to the iLife Media Browser. Follow these steps: 

1. In iMovie, select a project from your Project Library. 

2. Choose Share > Media Browser. A dialog appears with the same size 
options shown earlier in Share Movies with iMovie. 

3. Check the boxes for the movie sizes you want to make available to 
iWeb and other applications, and click Publish. 

Your shared movie now appears under iMovie in the Movies pane 
of the Media Browser. Then, in iWeb, drag one of the available movie 
sizes to a Web page or blog entry to include it on the page. 

PUBLISH A PODCAST WITH GARAGEBAND 
Creating a podcast involves recording an audio file, optionally editing 
it (to, say, add music or sound effects or to remove mistakes), upload-
ing it to a server, and putting a line of HTML code in a blog post so that 
RSS readers can see and download it. GarageBand and iWeb handle 
nearly all these details for you, making the job much simpler. 

To create a podcast, you’ll need a microphone. Although many Macs 
have built-in microphones, you’ll get better results from an external 
microphone. Some microphones require an adapter to connect to a 
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Mac. The directions that follow assume that you’ve already successfully 
connected a microphone and configured GarageBand to use it. 

To create a simple podcast episode, follow these steps: 

1. Open GarageBand, select New Project in the list on the left, select 
Podcast on the right, and click Choose. 

2. Enter an episode name, choose a storage location, and click Create. 

3. Select the Male Voice or Female Voice track, as appropriate, and 
click the Record button—the button with the red dot—to start 
recording. When you’re done, stop by clicking the Stop button 
(marked with a square) in GarageBand ’11, or the Play button 
(marked with a triangle) in GarageBand ’09. 

4. To add music, sound effects, or other audio embellishments, drag 
them from the Loop Browser to the desired location in your record-
ing. (If the Loop Browser isn’t visible, choose Control > Show Loop 
Browser [Command-L].) 

5. Choose Share > Send Podcast to iWeb, adjust any options you care 
to change, and click Share. GarageBand mixes down your recording, 
converts it to the correct format, and opens iWeb. 

6. In iWeb, choose a Blog or Podcast template, and click Choose. 

7. Enter text to accompany your podcast; you can also modify other 
information, such as the page’s title. 

8. Still in iWeb, choose File > Publish Entire Site; if you're adding to 
an existing site, File > Publish Site Changes. 

iWeb uploads your podcast, along with the new blog entry, and then 
displays a dialog with the site’s URL and buttons you can use to visit 
the site or send an email message announcing the site. 
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Create a Site Using Your Own Tools 
If you find iWeb too limiting, you can create Web pages using 
other software, and then copy those pages to the appropriate 
folder on your iDisk—either the iDisk/Web/Sites folder or a folder 
within iDisk/Web/Sites—to publish them. (Note that you may need 
to double-click the Web alias to display the Sites folder within it.) 
If you do decide to create your site using other tools, keep in mind 
the following: 

• Even if you do your own coding, the MobileMe Web site does 
not support server-side programming languages such as perl 
or PHP. You can, however, include JavaScript code. 

• To make a file the home page for a site—so it appears 
when someone enters a URL like http://web.me.com/ 
member-name/site-name/—name the file index.html. 

• Any file you place in the iDisk/Web/Sites folder or one of its 
subfolders is immediately available on the Web, via a URL of 
the form http://web.me.com/member-name/filename (for files 
at the top level of the Sites folder) or http://web.me.com/ 
member-name/folder-name/filename (for files in a subfolder). 

• Sites you previously published in the main iDisk/Sites folder 
will continue to appear with the URL http://homepage.mac.com/ 
member-name/site-name/, but all new sites should be put 
in iDisk/Web/Sites, and if you want existing sites to have a 
web.me.com URL (as opposed to a homepage.mac.com URL), 
you can move them from iDisk/Sites into iDisk/Web/Sites. 

• If you use a personal domain with your site, then instead 
of putting the folders for your sites in iDisk/Web/Sites, put 
them directly in iDisk/Web. Then they should be available at 
http://your-personal-domain/your-site-name/. 

Apple offers more details on uploading custom sites at 
http://support.apple.com/kb/HT2637. 

http://support.apple.com/kb/HT2637
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Access Your Mac 
Remotely 
 
Back to My Mac (BtMM), a MobileMe feature exclusively for users 
of Mac OS X, lets you easily connect to one of your Macs—or a Time 
Capsule or AirPort Disk—from another located elsewhere on the 
Internet in ways that were previously very difficult to set up, if not 
impossible. Once you have this feature configured properly, using it 
is every bit as simple as (in fact, it’s exactly the same as) connecting 
between two Macs on the same local network in your home or 
office—generally just a bit slower. 

That’s the good news. The bad news is that this remarkable 
capability belies considerable behind-the-scenes complexity, and 
because some of the many variables required for success may be 
beyond your (or Apple’s) ability to address, you may not be able 
to get it working in every situation. 

In this chapter, I describe what BtMM is designed to do, how to set 
up your Macs correctly, and how to use its capabilities. 

 

Additional BtMM Documentation 
Apple offers a free 8-page PDF user’s guide for BtMM, which 
you can download at http://images.apple.com/mobileme/docs/ 
L358808A_BackMac_UG_070708.pdf. 

However, that guide provides little detail and doesn’t address 
many of the situations in which you’ll need to jump through 
additional hoops to get BtMM working properly. For the complete 
scoop, read Glenn Fleishman’s Take Control of Back to My Mac; 
you can access a discount via the link in Ebook Extras near the 
end of this ebook. 

 

 

http://images.apple.com/mobileme/docs/L358808A_BackMac_UG_070708.pdf
http://images.apple.com/mobileme/docs/L358808A_BackMac_UG_070708.pdf
http://www.takecontrolbooks.com/back-to-my-mac?pt=INTERNAL
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WHAT BACK TO MY MAC CAN DO 
With BtMM, you can connect to a Mac, Time Capsule, or AirPort Disk 
(for example, your Mac at home) from another Mac elsewhere, such 
as in your office, in a hotel room while traveling, or at a coffee shop. 
The two devices may be on different networks; may have IP addresses 
that change from time to time; and may be connected to the Internet 
through routers that prevent most programs from seeing the 
computers directly, but BtMM works its magic to connect the two 
devices easily and securely, using the MobileMe servers to store 
information that helps your Mac locate the other device. 

Fresh Air: Glenn Fleishman explains the process of connecting to a 
Time Capsule or AirPort Disk (an external hard drive connected to an 
AirPort Extreme Base Station) in a free excerpt from his book Take 
Control of Your 802.11n AirPort Network, which you can read at 
http://www.takecontrolbooks.com/news/connecting-to-an-airport-
or-time-capsule-via-back-to-my-mac. 

When I say “connect,” I’m talking about two separate options: 

• File sharing: You can mount a remote Mac’s drive on your local 
Mac and then copy files between them, delete or rename remote 
files, or do anything else you normally could do with a network file 
server. The same goes for a Time Capsule or an AirPort Disk. 

• Screen sharing: You can see a live view of a remote Mac’s 
screen on your local Mac and control the remote Mac with your 
local keyboard and mouse, as though you were sitting at the remote 
computer. In this way, for instance, you can run applications on 
your home Mac that you don’t have with you on your laptop. 

Here and There: You can also do both of these things on a local 
network. Any Mac running Leopard or later with File Sharing or 
Screen Sharing enabled appears in the sidebar of Finder windows 
on local Macs, thanks to Apple’s Bonjour technology. BtMM simply 
extends this capability to devices that are separated by miles or 
continents (or, technically speaking, to devices on different 
networks). 

http://www.takecontrolbooks.com/airport-n?pt=INTERNAL
http://www.takecontrolbooks.com/airport-n?pt=INTERNAL
http://www.takecontrolbooks.com/news/connecting-to-an-airport-or-time-capsule-via-back-to-my-mac
http://www.takecontrolbooks.com/news/connecting-to-an-airport-or-time-capsule-via-back-to-my-mac
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CONFIGURE YOUR DEVICES 
Before we discuss configuration, I should clarify the requirements for 
using BtMM. First, you need at least one Macintosh (and usually two) 
running Leopard or later. (In lieu of one of the Macs, you could use 
a Time Capsule or an AirPort Disk—but only to access that drive for 
remote file sharing.) Second, you need a MobileMe membership. In 
addition, you need: 

• A compatible router for the Mac you’ll access remotely. This could 
be an AirPort Extreme, AirPort Express, or a third-party router that 
supports UPnP (universal plug-and-play) or NAT-PMP (network 
address translation-port mapping protocol). You can find a partial 
list of supported routers at http://support.apple.com/kb/TS1304. 

• Mac OS X 10.5.8 or higher—and preferably, the very latest version 
of Mac OS X and all other applicable Apple updates—on both ends. 

• A high-speed Internet connection on both ends. 

• To use Back to My Mac with a Time Capsule or AirPort Disk, 
make sure the device has firmware version 7.4.1 or later (see 
http://support.apple.com/kb/HT3466). 

Configuring BtMM requires just a few steps. Proceed as follows: 

On each Mac (local and remote): 
1. Go to the MobileMe pane of System Preferences. Verify (in the 

Account view) that you’re signed in; if you aren’t, enter your 
member name and password. 

2. In the Back to My Mac view (Figure 38), look for text near the top 
that says either “Back to My Mac: On” or “Back to My Mac: Off.” If 
it’s off, click the Start button. 

http://support.apple.com/kb/TS1304
http://support.apple.com/kb/HT3466
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Figure 38: Turn Back to My Mac on or off in this view. 

Then, on any Mac(s) you’ll access remotely: 
3. Click Open Sharing Preferences to switch to the Sharing pane. 

4. To enable screen sharing, check Screen Sharing (Figure 39). Then, 
to the right: 

a. Select the radio button for either All Users or, for greater 
security, Only These Users. 

b. If you chose Only These Users, click the plus  button, select the 
desired account name(s) from the list (or click New Person to 
add a name not already on the list), and click Select. 
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Figure 39: Enable Screen Sharing and File Sharing in this pane. 

5. To enable file sharing, check File Sharing. Then, to the right: 

a. Click the plus  button under “Shared Folders,” navigate to a 
folder or volume you want to be able to access remotely (such as 
your home folder or even your entire disk), select it, and click 
Add. (Each user’s Public folder is already listed by default.) 

b. With that folder or volume selected, confirm that your name— 
or the name of the person to which you want to provide remote 
access—appears under “Users” with Read & Write access. If not, 
click plus  to add that person, and if your access is anything 
other than Read & Write, choose Read & Write from the pop-up 
menu for that name. 

To share a Time Capsule or AirPort Disk: 
The following steps assume that you have already configured file 
sharing on the Time Capsule or AirPort Disk, and that it works 
correctly on your local network. 
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1. Open AirPort Utility (in /Applications/Utilities) and select your 
Time Capsule or AirPort Extreme base station in the list on the left. 

2. Click Manual Setup, click the Advanced button on the toolbar, and 
then click the MobileMe button. 

3. Enter your MobileMe member name in the MobileMe Account field, 
and your MobileMe password in the Password field. Click Update 
and wait for your device to restart. Then quit AirPort Utility. 

After setting up your devices, check your router configuration. 

CONFIGURE YOUR ROUTER 
The final configuration step is to make sure the router that sits 
between the Mac(s) you’ll access remotely and the Internet is properly 
set up. This may be an AirPort base station, a DSL or cable modem, or 
in some cases more than one device. 

If you have an AirPort Extreme or AirPort Express, follow these steps: 

1. Open AirPort Utility (in /Applications/Utilities). 

2. Select your base station in the list on the left. 

3. Click Manual Setup. 

4. Choose Settings > Internet. 

5. In the NAT view, check Enable NAT Port Mapping Protocol. 

6. If you made any changes, click Update and wait for your base 
station to restart. 

If you have a third-party router, follow the manufacturer’s instructions 
to access its administrative interface (usually through a Web browser) 
and enable UPnP or NAT-PMP. 

If you have both an AirPort base station and another router, you may 
need to make additional changes to either or both devices. For more 
details, see Take Control of Back to My Mac or this article on Apple’s 
Web site: http://support.apple.com/kb/TS1208. 

http://www.takecontrolbooks.com/back-to-my-mac?pt=INTERNAL
http://support.apple.com/kb/TS1208
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GET BACK TO YOUR MAC 
Now that everything’s set up, go on a field trip. Take your laptop some-
where else (or go where another of your Macs is located). Make sure 
you’re connected to the Internet. If you look in the sidebar of a Finder 
window, you should see the icon for your remote Mac, Time Capsule, 
or AirPort Disk under Shared, just as you would if it were on the same 
local network. You can now connect to it to share its files or, in the case 
of a Mac, its screen. 

Share Another Mac’s Screen 
To control your remote Mac’s screen, select its icon in the sidebar, 
click Share Screen, and enter your credentials if prompted to do so. 
The screen appears in a window on the local Mac, and you can control 
the remote Mac using your keyboard and mouse. 

Access Files on Another Mac, 
a Time Capsule, or an AirPort Disk 
To access your remote device’s files, select its icon in the sidebar, click 
Connect As, and enter your credentials if prompted to do so. A list of 
shares—volumes and shared folders—on your remote device appears. 
Double-click any share to mount it and display its files; you can then 
interact with them just as if they were on a local network server. 

Should the need arise, you can also configure your Time Capsule or 
AirPort Extreme base station remotely using Back to My Mac, assum-
ing you’ve previously enabled Back to My Mac on the device (described 
a couple of pages earlier). Simply open AirPort Utility and your remote 
device should appear in the list, along with any compatible devices 
found nearby. 
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Back Up Your Files 
 
Since your iDisk is always available as a network volume (at least 
as long as you’re connected to the Internet), and since its contents 
are inherently offsite, iDisk has an obvious attraction as a repository 
for backups. Apple even provides MobileMe users with a free utility 
(imaginatively named Backup) to assist in this process. 

But, as online storage services go, you can do better than iDisk for 
backup. And as backup programs go, Backup is not near the top of 
my list. In short, while I’m all in favor of online backups in theory, 
I suggest not using Backup; and, depending on your needs, perhaps 
not using your iDisk, either. I explain why in this chapter. 

USE iDISK FOR BACKUPS (OR NOT) 
Since data on your iDisk is stored safely offsite on Apple’s servers, 
anything you put there is protected against disasters that could affect 
your computer or local hard drives. You can get to the data from 
another computer if need be. So it’s a reasonable storage space for a 
modest amount of information. However, here are some reasons you 
might not want to store backups on your iDisk:  

• Your iDisk holds only 20 GB of data (or possibly as much as 60 GB, 
if you’ve paid for an upgrade), but your computer’s hard drive likely 
contains hundreds of gigabytes of data or more—so you may be able 
to back up only a portion of your files to your iDisk. 

• The more space you use on your iDisk for backups, the less is 
available for other purposes, such as sharing photos. 

Note: The latest version of Backup, 3.2, can recycle older backups 
to save storage space—see http://support.apple.com/kb/HT3991. 

• Copying files to and from an iDisk can be quite slow—even if you 
have a fast broadband Internet connection. 

• As of Mac OS X 10.6.4, transfers to and from your iDisk in the 
Finder aren’t encrypted (although published rumors state that SSL 

http://support.apple.com/kb/HT3991
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encryption for iDisk transfers will appear in Mac OS X 10.6.5); that 
being the case, unless your backup software encrypts files before 
uploading them (or you’re willing to upload backup archives man-
ually using your Web browser), you risk having your private data 
intercepted while in transit. 

• If you lose your Internet connection, or if Apple’s servers are 
unavailable for any reason, you can’t retrieve your backed-up files. 

In other words, your iDisk is not ideal as the only place to store 
backups. However, if you normally back up your Mac to an external 
hard drive or other local media, you might consider using your iDisk 
as a secondary destination—for your most important files, or for small 
files you want to safeguard until your next scheduled backup. Even 
then, I suggest using something other than Backup (as I discuss next). 

(DON’T) BACK UP WITH BACKUP 
Backup 3.2 is available right on your iDisk—it’s located in the 
Software/Backup folder—and you should feel free to try it if you’re 
interested. But compared to Time Machine, the slick backup software 
built into Mac OS X, Backup is downright quaint in its design. It’s not 
terrible—for basic backups it gets the job done—but it has too many 
limitations for my tastes.  

For example: 

• Backup 3.x was designed to back up only files in your home folder. 
If you try to back up other data—your whole disk, say, or all your 
programs—Backup won’t back up the data correctly. When you try 
to restore that data, you’ll be in for a nasty surprise. 

• Backup can’t compress or encrypt your data, and doing both is 
mighty important when storing your files online. 

• When a large file changes even slightly, Backup copies the whole 
thing again on its next run—rather than copying just the portion 
that changed. That can make backups take a very long time. 

In fact, I have a number of other complaints about Backup, but I 
won’t waste space enumerating them here. The only thing Backup has 
going for it is that it’s free for MobileMe members. But in my opinion, 
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it’s worth spending a few dollars on a much more capable program. 
Although I know of over 100 Mac backup programs (see detailed 
feature-comparison tables at http://www.takecontrolbooks.com/ 
resources/0014/), a few stand out as better choices for backing up your 
data to an iDisk. All of the following, for example, offer compression 
and encryption, and all can copy data directly to a mounted iDisk: 

• Data Backup:  
http://www.prosofteng.com/products/data_backup_info.php ($59) 

• Personal Backup, part of Internet Security Barrier X6: 
http://www.intego.com/internet-security-barrier/ ($49.95) 

• Retrospect Desktop: 
http://www.retrospect.com/products/software/retroformac/ ($119) 

• Tri-Backup:  
http://www.tri-edre.com/english/tribackup.html ($69) 

But you can do better still! In addition to offering compression and 
encryption features, several backup services/programs can do sub-file 
incremental updates (meaning they’ll copy only changed portions of 
files). Instead of using your iDisk as a destination, they use their own 
proprietary servers—but you get considerably more storage than your 
iDisk offers, and at a lower price.  

A few examples are: 

• Backblaze: 
http://www.backblaze.com/ ($5 per month or $50 per year for 
unlimited storage of data from a single computer) 

• CrashPlan+: 
http://www.crashplan.com/ ($59.99 for the software; unlimited 
storage starts at $3.50 per month) 

• JungleDisk: 
http://www.jungledisk.com/ ($2 to $5 per month, depending on 
edition; Amazon S3 storage costs extra) 

• MozyHome: 
http://www.mozy.com/ ($4.95 per month per computer) 

http://www.takecontrolbooks.com/resources/0014/
http://www.takecontrolbooks.com/resources/0014/
http://www.prosofteng.com/products/data_backup_info.php
http://www.intego.com/internet-security-barrier/
http://www.retrospect.com/products/software/retroformac/
http://www.tri-edre.com/english/tribackup.html
http://www.backblaze.com/
http://www.crashplan.com/
http://www.jungledisk.com/
http://www.mozy.com/
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In short: do back up your data, and do consider keeping at least a 
secondary copy of your data online. But think twice before using your 
iDisk for this purpose, and even if you do settle on iDisk, at least pick 
a backup program that’s better suited to the task than Backup. 
 

Tip: When it comes to backups, I wrote the book—in fact, a couple 
of them. In Take Control of Mac OS X Backups I walk you through 
developing and implementing a solid backup strategy; I include 
details about numerous backup programs, including Backup 3. 
For a much simpler approach to backups that focuses on Time 
Machine, bootable duplicates, and offsite backups, see Take 
Control of Easy Mac Backups. 

http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/backup-easy-mac?pt=INTERNAL
http://www.takecontrolbooks.com/backup-easy-mac?pt=INTERNAL
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Appendix A: Account 
Conversion Methods 
 
To convert a MobileMe account from one type to another, find your 
existing account type in Table 1 and follow the instructions. 

  

Table 1: Account Conversion Methods 

To convert 
from this: To this: Do this: 
Expired 
MobileMe 
membership 

Full MobileMe 
membership 

1. Sign in to MobileMe with your existing 
member name and password. 

2. Click Reactivate; follow the instructions. 

Email-only 
account or 
Family 
Member 
account 

Full MobileMe 
membership 
or Family 
Pack primary 
account 

1. Go to http://me.com/upgrade. 
2. Follow the instructions that appear. 

Full MobileMe 
membership 

Family Pack 
primary 
account 

1. Go to the MobileMe Account view. 
2. Click Account Options in the sidebar. 
3. Click the Upgrade button. 
4. Select Add the Family Pack to Your 

Account, and then click Continue. 
5. Enter your billing information. 

Trial or 
expired 
MobileMe 
membership, 
email alias, 
or email-only 
account 

Family 
Member 
account 

Have the primary account holder do this: 
1. Go to the MobileMe Account view.  
2. Click Account Options in the sidebar. 
3. Click the Set Up Account link next to an 

unused Family Member account. 
4. Click Convert an Existing Account or 

Convert an Email Alias, as appropriate. 
5. Enter the member name and password 

for your (trial or expired) membership, 
or select the email alias to convert. 

6. Click Continue, and then click Done. 
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About This Book 
 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments at 
tc-comments@tidbits.com. 

EBOOK EXTRAS 
You can access extras related to this ebook on the Web. Once you’re on 
the ebook’s Take Control Extras page, you can: 

• Download any available new version of the ebook for free, or buy a 
subsequent edition at a discount. 

• Download various formats, including PDF and—usually—EPUB and 
Mobipocket. (Learn about reading this ebook on handheld devices 
at http://www.takecontrolbooks.com/device-advice.) 

• Read postings to the ebook’s blog. These may include new infor-
mation and tips, as well as links to author interviews. At the top of 
the blog, you can also see any update plans for the ebook. 

• Get a discount when you order a print copy of the ebook. 

ABOUT THE AUTHOR 
Joe Kissell is Senior Editor of TidBITS, a Web site and 
email newsletter about the Macintosh and the 
Internet, and the author of numerous print and 
electronic books about Macintosh software, including 
Take Control of Running Windows on a Mac and Take 
Control of Mac OS X Backups. He is also a Senior 
Contributor to Macworld, was the winner of a 2009 Neal award for 
Best How-to Article, and has appeared on the MacTech 25 list (the 25 
people voted most influential in the Macintosh community) since 
2007. Joe has worked in the Mac software industry for over 10 years, 
including positions managing software development for Nisus 
Software and Kensington Technology Group. 

mailto:tc-comments@tidbits.com
http://www.takecontrolbooks.com/checkforupdates?mw=logperch&bt=0071&bv=2.0
http://www.takecontrolbooks.com/device-advice
http://www.takecontrolbooks.com/windows-on-mac?pt=INTERNAL
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL
http://www.takecontrolbooks.com/backup-macosx?pt=INTERNAL


138 

In his increasingly imaginary spare time, Joe likes to travel, cook, walk, 
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send him email at jwk@me.com and be sure to include the words Take 
Control of MobileMe in the subject of your message. 

AUTHOR’S ACKNOWLEDGEMENTS 
Special thanks to Dan Frakes for his outstanding editing and insightful 
comments. I also appreciate the feedback from other Take Control 
authors and members of the TidBITS Irregulars list. 

SHAMELESS PLUG 
Although I write about computers as my day job, I have a great many 
other interests, which I write about on several Web sites, including 
Interesting Thing of the Day and my personal blog. You can find links 
to all my sites, a complete list of my publications, and more personal 
details about me at JoeKissell.com. 

ABOUT THE PUBLISHER 
Publishers Adam and Tonya Engst have been 
creating Apple-related content since they 
started the online newsletter TidBITS, in 1990. 
Adam and Tonya are known in the Apple world 
as writers, editors, and speakers. They are also 
parents to Tristan, who thinks ebooks about castles would be cool. 

PRODUCTION CREDITS 
Take Control logo: Jeff Tolbert 

Cover design: Jon Hersh 

Editor: Dan Frakes 

Editor in Chief: Tonya Engst 

Publisher: Adam Engst 

mailto:jwk@me.com?subject=Take%20Control%20of%20MobileMe
http://itotd.com/
http://joekissell.com/


139 

Copyright and Fine Print 
 

  
  

Take Control of MobileMe, Second Edition 

ISBN: 978-1-61542-093-3 

Copyright © 2008, 2009, 2010, Joe Kissell. All rights reserved. 
  

TidBITS Publishing Inc. 

50 Hickory Road 

Ithaca, NY 14850 USA 

http://www.takecontrolbooks.com/ 
  

Take Control electronic books help readers regain a measure of control in an oftentimes 
out-of-control universe. Take Control ebooks also streamline the publication process so 
that information about quickly changing technical topics can be published while it’s still 
relevant and accurate. 

This electronic book doesn’t use copy protection because copy protection makes life harder 
for everyone. So we ask a favor of our readers. If you want to share your copy of this ebook 
with a friend, please do so as you would a physical book, meaning that if your friend uses it 
regularly, he or she should buy a copy. Your support makes it possible for future Take 
Control ebooks to hit the Internet long before you’d find the same information in a printed 
book. Plus, if you buy the ebook, you’re entitled to any free updates that become available. 

Although the author and TidBITS Publishing Inc. have made a reasonable effort to ensure 
the accuracy of the information herein, they assume no responsibility for errors or 
omissions. The information in this ebook is distributed “As Is,” without warranty of any 
kind. Neither TidBITS Publishing Inc. nor the author shall be liable to any person or entity 
for any special, indirect, incidental, or consequential damages, including without 
limitation lost revenues or lost profits, that may result (or that are alleged to result) from 
the use of these materials. In other words, use this information at your own risk. 

Many of the designations used to distinguish products and services are claimed 
as trademarks or service marks. Any trademarks, service marks, product names, or named 
features that appear in this title are assumed to be the property of their respective owners. 
All product names and services are used in an editorial fashion only, with no intention of 
infringement of the trademark. No such use, or the use of any trade name, is meant to 
convey endorsement or other affiliation with this title. 

This title is an independent publication and has not been authorized, sponsored, 
or otherwise approved by Apple Inc. Because of the nature of this title, it uses terms that 
are trademarks or that are the registered trademarks of Apple Inc.; to view on the Web a 
complete list of the trademarks and of the registered trademarks of Apple Inc., you can 
visit http://www.apple.com/legal/trademark/appletmlist.html. 

http://www.takecontrolbooks.com/
http://www.apple.com/legal/trademark/appletmlist.html


140 

Featured Titles 
 
Click any book title below or visit our Web catalog to add more 
ebooks to your Take Control collection! 

 
Take Control of Apple Mail in Snow Leopard (Joe Kissell): Go under 
the hood with the new (and old) features in Apple Mail 4. Joe gets you 
going and helps you get the most out of Mail. $15 

Take Control of Back to My Mac (Glenn Fleishman): Learn how this 
file- and screen-sharing service from Apple works and what to do with 
it, and get help with tricky router configurations. In Ebook Extras, a 
few pages earlier, click the link to access a special deal wherein you can 
buy this ebook for only $5. 

Take Control of Easy Mac Backups (Joe Kissell): Devise a rock-solid 
backup strategy so you can restore quickly and completely, no matter 
what the catastrophe. $10 

Take Control of Exploring and Customizing Snow Leopard (Matt 
Neuburg): Learn how to customize your Mac’s interface, navigate 
quickly around your disk, and use special features like a pro. $15 

Take Control of iPhone Basics (Karen Anderson) Learn fundamental 
iPhone facts so you can get avoid newbie mistakes and get more out of 
your shiny device. $10 

Take Control of iTunes 10: The FAQ (Kirk McElhearn): This FAQ-style 
ebook helps you wrap iTunes around your little finger and enjoy your 
media more. $10 

Take Control of Mail on the iPhone and iPod touch, iOS 4 Edition 
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email effectively on your Apple devices. $10 
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